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Navigating this document:
Please use one of the methods described below to quickly find the desired informa-
tion in this on-line documentation:

• Use the Table of Contents provided by the Acrobat Reader program.
• Use the Adobe Acrobat Reader Search function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is of course possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be 
found in its on-line Help.

Welcome to ReCycle!
First of all we’d like to thank you for purchasing ReCycle! You are now in posses-
sion of a unique tool which will be an enormous time saver and which will add 
great creative possibilities to your music making.

Before ReCycle, using drum loops was very technical. Also, once you had commit-
ted yourself to a sample, you were stuck with its inherent tempo, its bass drum pat-
tern, its snare sound etc. A bit like painting by numbers.

With ReCycle all that has changed. This program puts you – the musician – back in 
control, and lets you concentrate on what you do best. Which of course is creating 
music.
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What can I do with ReCycle?
With ReCycle, you can perform a number of pretty amazing “tricks” on your drum 
loops:

• Change the tempo without affecting pitch.
• Change the pitch without affecting tempo.
• Quantize drum loops (either to straighten up the timing or to change the feel, 

for example by applying a “groove map”).
• Extract the timing (a groove map) from a drum loop. This can then be applied 

to other sequenced parts or even to other loops!
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.
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Copyright Issues
The raw material with which you feed ReCycle is drum loops, grooves, breakbeats, 
or whatever sampled weirdness you find appropriate. Included in this package is a 
great selection to get started with. When you grow out of that you’ll find a wealth of 
other sampling CDs and CD-ROMs out on the market to pick from. However, 
please read the following text carefully:

Every published recording carries a warning, like this:

• "All rights of the producer and owner of the recorded work are protected by 
law, unauthorized copying, public performance..."

The text above means it is illegal to use this recording in your own work, unless you 
obtain permission (see below). 

● Failing to observe a copyright warning may result in legal action taken against 
you. Make absolutely sure any material you use in your own recordings is 
cleared for use, or you may find yourself in serious legal trouble!

Some CDs (and other media) are created specifically for sampling. Even then you 
must ensure the result is properly cleared for use in your own recordings. If you 
find a disclaimer text that goes something like the one below, beware:

• "Every effort has been made to ensure that this CD contains sounds you can 
safely use in your music. However, the producers of this product can not ac-
cept responsibility for any direct or consequential loss..."
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In this case, please contact the producer to find out exactly what applies. Again, do 
not use any material from this medium without making sure it is properly cleared 
for use.

Clearing

So, how do you go about obtaining permission to use a recording, often referred to 
as “clearing a sample”?

The owner of a CD is listed on the CD, in conjunction with a “P” symbol and a 
date. Contact the owner to obtain permission. If you can’t find the owner, contact 
the company following the © symbol on the CD. If you can’t find that either, con-
tact the manufacturer or record label listed on the packaging. Please note that there 
are several types of clearance, for different types of usage. Preferably contact an at-
torney familiar with copyright law, for assistance.
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About This Manual
This manual covers both the Macintosh and Windows versions of ReCycle. Most 
pictures show the Macintosh version but things are identically titled and positioned 
in both versions.

Sometimes, a key command is different in the two versions. In this case, this is in-
dicated like this:
Hold down [Option] (Mac) / [Alternate] (Win) and...

If a paragraph specifically relates only to either version of the program, this is indi-
cated like this:

Macintosh version only.

Windows version only.

Mac:

Win:
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Show us what you do with ReCycle!
We created ReCycle because we needed it in our own music making. You bought 
ReCycle to make music with it. So, the music is the link between us developers and 
you, our users. We are really interested in hearing what kind of music you create 
with the program. So, please send a copy of your work together with suggestions 
and comments, to:

Steinberg Soft- & Hardware GmbH
ReCycle! Department
Eiffestrasse 596
20537 Hamburg
Germany
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Requirements
To use ReCycle for Macintosh you need the following:

• A 68030 or 68040 type Macintosh with 4MB RAM and a hard disk, or...
• Any Power Macintosh.

ReCycle comes in two versions, one for 68030 and 68040 Macintoshes 
(“68k”) and one for Power Macintosh (“PPC”). The installation routine auto-
matically detects which type of computer you have and installs the appropri-
ate version.

• System 7.5, or  System 7/7.1 with QuickTime installed.

For communication with your specific sampler, you might also need:

• A MIDI Interface and cables, and/or...
• SCSI cables.
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Setting Up The Computer
Before proceeding, your computer should be set up and you should be reasonably 
familiar with its operation. You should also install all peripherals, such as MIDI in-
terface etc.

Setting Up The Sampler, MIDI and SCSI
1. Look up the Appendix that describes your specific sampler and check the 

heading “Support and Requirements”.
If you are reading this on-screen you can click directly on links which take 
you to the relevant sections:

• Digidesign: Requirements and Support
• Akai: Requirements and Support
• Roland: Requirements and Support
• Kurzweil: Requirements and Support
• Ensoniq: Requirements and Support
• E-mu: Requirements and Support

2. If the sampler connection requires MIDI, turn to Appendix A and install 
OMS as described there.
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3. Again, please look up the relevant sampler Appendix, and install and set 
up the sampler as described there.

● Please read the section about your specific sampler thoroughly before install-
ing ReCycle. If your sampler communicates with the computer via SCSI, 
please note that improper SCSI connections may cause permanent damage to 
the computer, sampler and other SCSI peripherals.

Turning on your system
1. If you have any peripherals connected to the computer or sampler, al-

ways turn these on first.

2. If you are using a sampler with the operating system on a floppy disk or 
hard disk, make sure the operating system is loaded before you turn on 
your computer.

3. Turn on the computer.
It should come alive, showing the desktop after a while. If it doesn’t, check 
your SCSI setup as described at the end of this manual.
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Installing ReCycle
1. Insert the ReCycle CD-ROM. In the window that appears, double click 

the icon named “ReCycle Installer”.

The installer icon.

2. Use the options in the dialog to select a hard disk with a System folder on 
it. Follow the instructions on screen.

3. Click the “Install” button.

4. At the end of the installation you will be required to restart your compu-
ter. Do so.

Read the Read Me file!
In the ReCycle! folder that was created on your hard disk during installation you 
will find a file called ReadMe. This will contain any late-breaking updates that 
didn’t make it into the manual. Please double click on it and read it before proceed-
ing.
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Register your software!
Please fill out and send in the registration card that comes in this package. Doing so 
will make sure you are entitled to technical support and kept aware of updates and 
other news regarding ReCycle. In addition, there might be other benefits, listed on 
the card.
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Setting up Audio
ReCycle plays back audio directly from your computer, using whatever sound ca-
pabilities it has. For example, if you only have 8-bit audio, this is what will be used. 
If your Macintosh has 16 bit 44.1kHz audio quality, then this is what you get. If you 
have a Sound Manager compatible audio card installed, the audio can be routed to 
this.

● Please note that the quality of the sound during direct playback from the com-
puter may not be immaculate. However, this does not reflect the final audio  
in the sampler, since this always maintains highest possible quality.

If you want to use the internal audio in your computer, we recommend that you 
connect the audio output on the back to your sound system instead of using the 
Macintosh built in speaker.
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Sound Manager Required!

For System 7.0 and 7.1 Users

When installing ReCycle, the extension Sound Manager 3.x (where the “x” is a 
number) and Sound control panel are copied to your System folder. However, if 
you run System 7.0 or 7.1 (as opposed to 7.5), you also need to have Apple Quick-
Time 1.61 (or later) installed, for the Sound Manager 3.x to work properly.

● If you don't have Apple QuickTime installed, ReCycle will not make any 
sound on your Macintosh!

QuickTime is not included with ReCycle. If you don't already have it, please con-
tact your Apple dealer for a copy and instructions on how to install it.

For System 7.5 Users

System 7.5 and later has the appropriate Sound Manager version built in. Conse-
quently, if you run 7.5, the Installation script will not copy these files to your hard 
disk. 7.5 users should simply set up audio using the Monitors and Sound control 
panel included with the System. 

However, in order to use ReCycle with a Digidesign audio card, System 7.5 users 
need the “Digidesign Sound Drivers”, just like everyone else. See below.
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If you use a sound card

1. If you want to use a Sound Manager 3.0 compatible audio card or periph-
eral, install it as recommended by the manufacturer.

2. Connect the card to your sound system.

3. Install the driver file for the card.
On the ReCycle disk you will find a package with all files you need for 
Digidesign cards, including documentation on how to install it. How to direct 
the Macintosh system sound to the card is also described in that documenta-
tion.
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Launching ReCycle and authorizing the hard disk

● ReCycle uses floppy disk based copy protection. The ReCycle Master Disk is 
your master disk, your verification that you have bought the program. Follow 
the instructions below meticulously. After installation, keep the master disk in 
a safe place.

Before you can use ReCycle you need to authorize your hard disk. This is only 
done once and the copy protection is then totally “transparent”.

1. Locate your ReCycle program icon (in the new “ReCycle!” folder on the 
hard disk, not on the CD-ROM) and double click on it.

2. The program prompts you to insert the master disk (if not already in the 
drive).
The following dialog box appears.

The Authorization dialog box.
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3. Click the “Authorize” button.

4. After a while a new dialog appears telling you the installation is done. 
Click OK.
The program automatically launches.

For more information on the copy protection and instructions on how to “deauthor-
ize” the hard disk, see page 32.
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Selecting a Sampler
Before you can Receive or Transmit audio you must tell the program which sam-
pler you want to use. Pull down the Sampler menu. At the bottom of this you will 
find a list of samplers.

The Sampler list.

Some of these items are always active and some are greyed out until a particular 
sampler has been detected.

• Samplers that ReCycle doesn’t require to actually be connected and turned on 
will always be selectable. An example of such a sampler is Digidesign Sam-
pleCell.

• Samplers that have to be connected properly and turned on, will be greyed 
out if not found by the program on startup.
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About Samplers Connected via SCSI

For ReCycle to recognise samplers connected via SCSI, the following criteria must 
be met:

• It must be a sampler model that ReCycle supports.
• The sampler must be loaded with the required operating system.
• To be recognised on startup, the sampler must be turned on when ReCycle is 

launched.
• No other device on the “SCSI bus” must be set to the same SCSI ID.

About Samplers Connected via MIDI

For ReCycle to recognise samplers connected via MIDI, the following criteria must 
be met:

• It must be a sampler model that ReCycle supports.
• The sampler must be loaded with the required operating system.
• Both MIDI In and Out on the sampler must be connected to the computer.
• To be recognised on startup, the sampler must be turned on when ReCycle is 

launched.
• The sampler must be defined correctly in OMS.
ReCycle 1.6 - Macintosh Installation Page  27 



Selecting the Sampler From the Menu

To route the receive and transmit functions to a particular sampler, select it from the 
lower section of the Sampler menu.

An Akai S3000 selected.

You can have more than one sampler of the same type connected, provided they are 
set to different IDs, so that ReCycle can differentiate between them. If you do, the 
two samplers will appear below each other, distinguished by an ID number.

Two S3000s found by the program.
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Using “Search For Samplers”

As stated earlier, you should turn on your external equipment before turning on the 
computer and launching ReCycle. However, if you forget to do things in the right 
order, you might be able to add a sampler to the menu when the program is already 
running:

1. Turn on the external equipment, that you forgot earlier.

2. If the sampler has its operating system on disk, make sure it is loaded be-
fore you proceed.

3. Pull down the Options menu and select Search for Samplers. 
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RAM setting and Audio files
Every Macintosh program has a memory setting. This is used to tell the computer 
how much RAM memory to reserve for a particular program. This setting can be 
changed from the Finder as described below.

When ReCycle ships, you will be able to load over 10 seconds worth of audio. This 
is a total figure which can be divided by as many windows as you like. You might 
for example have a 6 seconds long sample in one window and a 4 seconds long 
sample in another window.

In addition to this, more free memory is needed when you transmit samples to your 
sampler.

If you find you need to increase the amount of RAM dedicated to ReCycle, proceed 
as follows:

1. If ReCycle is running, save the files you are working on.

2. Quit ReCycle.

3. Locate the ReCycle icon in the Finder and click on it once to select it.

4. Select Get Info from the File menu. Exactly what the dialog that appears 
looks like depends on what System software version you are using. What 
you are looking for is the setting that assigns additional memory to ReCy-
cle.
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5. Change the memory setting by clicking on it and typing in a new value.
As a guideline, for each 100kbyte that you increase the setting with, you will 
be able to load approximately one more second of sound.

6. Now, ReCycle will use this amount of RAM, if it is available. If there isn’t 
that much memory for it to “grab” (you might have other programs run-
ning which already occupy some of your memory), it will use as much as 
it can get. If the program can’t even find the “minimum” amount of RAM, 
it won’t start.

For more information about the memory settings in the Get Info dialog, see your 
Macintosh manual.
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About the Copy Protection
As you noted when installing ReCycle, you are allowed to authorize one hard disk 
to run the program. If you send in the registration card that comes in this package 
you will receive another master disk which entitles you to one more installation.

Please observe the following points:

• If you should accidentally delete the “ReCycle!” program file, don’t worry. 
Just drag a new copy from the master disk onto your hard disk. Even if you 
have deleted the program file, the hard disk is still authorized to run one copy 
of ReCycle.

• You can safely defragment (sometimes called “optimizing”) your hard disk. 
Copy protection is not affected by defragmentation.

• If you experience a hard disk crash, you may lose your ReCycle installation. 
Please contact your dealer if this happens.

• The installation creates an invisible file on the main root of the hard disk. 
Since it is invisible it can normally not be changed or deleted. Do not ever re-
move this file, since it will make you lose an installation count.

• Never reformat or partition your hard disk without “deauthorizing” it first (see 
below).
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Deauthorizing the Hard Disk

Should you ever need to permanently move your ReCycle installation to another 
computer, you need to deauthorize the hard disk where you have installed the pro-
gram. Proceed as follows:

1. Write enable your master disk, insert it into the disk drive, and double 
click on the “Deauthorize ReCycle” program icon (on the floppy disk).

2. Click “Setup...” in the first dialog and “Deauthorize” in the second. Fol-
low the instructions on screen.
You can now install the program on the new hard disk as described above.
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Requirements
To use ReCycle for Windows you need the following:

• A 386DX (or better) computer running at 33 MHz or faster.
• A VGA monitor.
• 4 MByte RAM, or more (for Windows 95 itself, 8 MByte is required).
• A hard disk with an absolute minimum of two megabyte of free disk space.
• An Multimedia Extensions/Windows 95 compatible sound card. In this in-

stance, we mean a card capable of reading audio files from a hard disk and 
playing them back.

• Microsoft Windows™ 3.1 or later. ReCycle supports Windows 95.

Do I need SCSI or MIDI?
• To find out if ReCycle requires you to install a MIDI or SCSI interface 

card, look up the Appendix that describes your specific sampler, and 
check the heading “Support and Requirements”.
If you are reading this on-screen you can click directly on links which take 
you to the relevant sections:

• Digidesign: Requirements and Support
• Akai: Requirements and Support
• Roland: Requirements and Support
• Kurzweil: Requirements and Support
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• Ensoniq: Requirements and Support
• E-mu: Requirements and Support
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Setting Up The Computer
Before proceeding, your computer should be set up and the following items should 
be installed:

• Your version of Windows.
• The audio card and its driver.
• If required, the SCSI card and its driver.
• If required, the MIDI interface and its driver.

You should also be reasonably familiar with operating the computer.

Checking the Audio Card

To make sure the audio card will work as expected, perform the following two tests:

• Use the software included with the sound card to make sure you can 
record and play back audio without problems.

• Use the Media Player application (included with Windows and described 
in the Windows documentation) to play back audio.
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Installing MIDI Interfaces

1. Install the MIDI interface, following the instructions in the manual that 
came with it.

2. Turn on the interface if needed.

3. If required, install the driver for the interface.

Installing SCSI

ReCycle works with any SCSI host adapter that is 100% “Adaptec compatible”.

● We strongly recommend that you use original Adaptec cards if at all possible. 
Small deviations in SCSI implementations can cause transfer problems.

About Base Addresses and IRQ

Just like a MIDI interface, the SCSI host adapter will have a base address and an 
IRQ setting. Make sure that no two cards in your computer use the same base ad-
dress or IRQ, or the computer will not run properly! For example, some Adaptec 
cards default to base address 330, which is also the standard for regular MPU MIDI 
cards. In this case, you must move either the SCSI or the MIDI card to another base 
address!
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● Do not connect anything to the SCSI card until you have finished installation 
of the card and its drivers. Also read the section about your specific sampler 
thoroughly before making any SCSI connections.

If you use Windows 3.1 or 3.11

Windows 3.1 and 3.11 have no built in support for SCSI cards. If you run any of 
these Windows versions you need an “ASPI for DOS” or “ASPI for Windows” 
driver.

With some cards, this software has to be purchased separately. Adaptec’s “ASPI for 
DOS” driver, for example, is part of a package called “EZ-SCSI” which may, or 
may not be included with the card.

The ASPI driver is required for ReCycle to communicate via SCSI under Windows 
3.1 or 3.11. You cannot run the card with the driver that is in BIOS ROM.

● Be sure to use any diagnostic utilities included with your ASPI version to verify 
that the card and its driver have been installed properly, before you start using the 
card with ReCycle!

About SCSI IDs

The SCSI host adapter itself normally has its SCSI ID set to 7. This means that no 
other device can be set to SCSI ID 7.
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Setting Up The Sampler
• Follow the instructions in the relevant sampler Appendix, for installing 

and setting up the sampler.

● Please read the section about your specific sampler thoroughly before install-
ing ReCycle. If your sampler communicates with the computer via SCSI, 
please note that improper SCSI connections may cause permanent damage to 
the computer, sampler and other SCSI peripherals.

Verifying SCSI Communication with the Sampler

ASPI for DOS

When you turn on your computer, the SCSI host adapter software is able to list all 
recognised SCSI devices and their SCSI IDs (the name of the sampler, however, 
might not be displayed correctly). If your card doesn’t do this, you will have to 
make a change in your CONFIG.SYS file (add a “/D” switch to the device line that 
installs ASPIxDOS, where the “x” is any number.) Please check the instructions 
that came with the SCSI host adapter card, if in doubt.
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ASPI for Windows

If you run ASPI for Windows, use the utility “SCSI Interrogator” (or equivalent) to 
check that the sampler appears on the SCSI bus. Note that the name of the sampler, 
however, might not be displayed correctly.
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Turning on your system
1. If you have any peripherals connected to the computer, always turn these 

on first.

2. If you are using a sampler with the operating system on a floppy disk or 
hard disk, make sure the operating system is loaded before you turn on 
your computer.

3. Turn on the computer and launch Windows.
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Installing ReCycle
ReCycle comes on CD-ROM. A special installation procedure unpacks all the files 
and puts them in the right places, automatically.

1. Start the computer and launch Windows.

2. Insert the CD-ROM in the drive. 

3. Locate the file called “Install.exe” in the ReCycle directory on the CD-
ROM and double click on it.

4. After a while, this dialog box will appear.

5. Check the command line. It currently says c:\recycle. This means that 
ReCycle will be installed on your “C:” hard drive, in a directory called 
“recycle” (this directory will be created if it doesn’t exist).
If you wish, you may specify another path name or another drive.
ReCycle 1.6 - Windows Installation Page  43 



6. When the actual installation is done (it will take a while), a new dialog 
appears, allowing you to create a new Program Group/Start Menu item 
for ReCycle or select one of the existing ones, from the pop-up.
You might for example put ReCycle in the Program Group where you already 
have your sequencer program. Follow the on-screen instructions.

7. Next, a text window may appear with information about changes to the 
program since this manual was written. Please read this carefully.

8. Locate the Program Group/Start menu item where you decided to put Re-
Cycle.
You will find two new items, ReCycle (the program itself) and a Notepad file 
called ReadMe.

● The ReadMe file will contain any late-breaking updates that didn’t make it 
into the manual. Please double click on it and read it before proceeding

ReCycle installed in its own Program Group under Windows 3.11.
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Register your software!
Please fill out and send in the registration card that comes in this package. Doing so 
will make sure you are entitled to technical support and kept aware of updates and 
other news regarding ReCycle.
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Launching ReCycle and authorizing the hard disk

● ReCycle uses floppy disk based copy protection. The ReCycle Master Disk is 
your master disk, your verification that you have bought the program. Follow 
the instructions below meticulously. After installation, keep the master disk in 
a safe place.

1. Locate your ReCycle program icon (in the new “ReCycle!” Program 
Group) and double click on it.
The program will now search for samplers connected to the computer.

2. Now, the following dialog box appears, asking you to insert the master 
disk.

3. Insert the disk and click OK.
Checking the disk might take some time. Please have patience.

4. The program launches and the File Open dialog appears.
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● If you ever change your computer’s configuration in any way, the Master Disk 
will be required next time you launch ReCycle. Always have the Master Disk 
available in case it is requested.

For more information on the copy protection see page 52.
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Selecting a Sampler
Before you can Receive or Transmit audio you must tell the program which sam-
pler you want to do this from. Pull down the Sampler menu. At the bottom of this 
you will find a list of samplers.

The Sampler list.

Some of these items are always active and some are greyed out until a particular 
sampler has been detected.

• Samplers that ReCycle doesn’t require to actually be connected and turned on 
for the program to work properly will always be selectable. An example of 
such a sampler is Digidesign SampleCell.

• Samplers that have to be connected properly and turned on, will be greyed 
out if not found by the program on startup.
ReCycle 1.6 - Windows Installation Page  48 



About Samplers Connected via SCSI

For ReCycle to recognise samplers connected via SCSI, the following criteria must 
be met:

• It must be a sampler model that ReCycle supports.
• The sampler must be loaded with the required operating system.
• To be recognised on startup, the sampler must be turned on when ReCycle is 

launched.
• No other device on the “SCSI bus” must be set to the same SCSI ID.

About Samplers Connected via MIDI

For ReCycle to recognise samplers connected via MIDI, the following criteria must 
be met:

• It must be a sampler model that ReCycle supports.
• The sampler must be loaded with the required operating system.
• The MIDI Interface must be installed in the Windows Control Panel.
• Both MIDI In and Out on the sampler must be connected to the computer.
• To be recognised on startup, the sampler must be turned on when ReCycle is 

launched.
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Selecting the Sampler From the Menu

To route the receive and transmit functions to a particular sampler, select it from the 
lower section of the Sampler menu.

An Akai S3000 selected.

You can have more than one sampler of the same type connected, provided they are 
set to different IDs, so that ReCycle can differentiate between them. If you do, the 
two samplers will appear below each other distinguished by an ID number.

Two S3000s found by the program.
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Using “Search For Samplers”

As stated earlier, you should turn on your external equipment before turning on the 
computer and launching ReCycle. However, if you forget to do things in the right 
order, you might be able to add a sampler to the menu when the program is already 
running:

1. Turn on the external equipment that you forgot earlier.

2. If the sampler has its operating system on disk, make sure it is loaded be-
fore you proceed.

3. Pull down the Options menu and select Search for Samplers. 
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About the Copy Protection
When you installed ReCycle you authorized your computer to run ReCycle. 

Please observe the following points:

• If you change your computer’s configuration in any way, the Master Disk will 
be required next time you launch ReCycle.

• You can safely defragment (sometimes called “optimizing”) your hard disk. 
Copy protection is not affected by defragmentation.
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How ReCycle Works
There are many things you can do with ReCycle. But the most common application 
is to slice a loop for tempo changes or editing. These are the basic steps (details fol-
low later in this chapter):

1. Load the loop in from your sampler, or, if you have the loop as an audio 
file on your hard disk, open it.
The program now analyses the loop and detects the individual “hits” or 
“sounds” in it. It then displays it as a waveform in a window.

2. The second step is to work with the Sensitivity fader and the tools to set 
up a number of slices.
Each slice represents an individual sound in the loop. Slices are displayed as 
vertical lines across the waveform.

3. The slices are now used for setting up loop points. You can play back the 
audio directly in ReCycle to check that the loop is correct.
The loop settings are later used by ReCycle to calculate the tempo of the sam-
pled loop, among other things.
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4. Once you have the slices and loop points set up as desired, it is time to 
transmit the slices back to the sampler. Only this time, each slice is trans-
mitted as an individual sample.
The samples are automatically mapped across the “keyboard” in the sampler, 
chromatically. This means that if you play the new samples in succession, you 
get the original loop back. This would be very hard to do by hand, so...

5. The last step is to let the program create a MIDI file that will play the 
slices, one after the other each with the correct length.

6. Once all this is done, you are finished with ReCycle. Now you load the 
MIDI file into your sequencer program and play it back from there.
This will perfectly recreate the way the loop originally was. But now that the 
loop is broken down into slices, you can change the tempo in the sequencer 
and the loop will follow. You can also perform detailed editing, quantizing 
and other operations on the MIDI file. This will be equivalent to editing the 
loop, since each note in the MIDI file directly represents a sound in the loop!

On the following pages you will find a quick tutorial. After this are handling in-
structions for all different aspects of the program. In the chapter “Example Appli-
cations” you will find more practical examples of what you can do with ReCycle.
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A Step By Step Example
The text below assumes you have installed ReCycle and a MIDI sequencer such as 
Cubase and that all connections to your sampler are set up and working. If not, 
please see the Installation chapter for more information.

1. Launch ReCycle by double clicking on its icon.
A File dialog appears.

2. Locate the file called “Drum Tools Demo”.
This is found in your ReCycle folder.

2. Locate the file called “DRUMDEMO.AIF”.
This is found in your ReCycle directory.

3. Select the file and click Open.

The Drum Tools Demo loop.

Mac:

Win:
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4. In the window, click the Play button.
You should now hear the entire loop, from start to end, repeating until you 
click the Play button again.

The Play button.

5. Raise the Sensitivity fader to some value between 70 and 80, so that a 
number of lines appear.
We call those lines and their triangle symbols “slices” since they indicate that 
the sound has now been cut up into slices.

The Sensitivity fader and some slices.
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6. Position the mouse pointer over the “L” handle (the Left Locator) and 
drag it to the right a bit and release it.
As you will see, it winds up exactly on one of the slices, and on the next lap, 
playback starts from this point.

7. Drag the Left and Right Locators until the loop is exactly one bar long.

The Locators set up correctly.

8. With playback turned off, click on the slices in the waveform view.
You will hear each individual sound in the loop.

9. Click in the “Bars” field, type “1”, and hit [Return].
The actual tempo of the loop gets calculated.

The Bars/Beats settings and the calculated Tempo.
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10.Pull down the Sampler menu and check the Transmit options (the items 
from “Transmit as One Sample” to “Silence Selected”). They should all be 
turned off (no tick mark). 

11.Move the mouse over the “Stretch” item. A sub-menu appears. From this, 
select 25%.
You can read more about what Stretch does on page 113.

So, now we have everything we need, a perfect loop, a tempo, a good set of slices 
and a stretch setting. Let’s send this stuff to the sampler.

12.Pull down the Sampler menu and select the sampler you want to use, at 
the bottom of the menu. 
Some samplers are always available. Other samplers can only be selected 
when they have been found by the program on startup. See page 107 for de-
tails.
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13.Pull down the Sampler menu and select Transmit (or if you have an inter-
nal sampler – Export).
Exactly what the dialog box that appears looks like depends on the sampler. 
As an example, we’re showing the Akai S3000 dialog.

The S3000 Transmit dialog

14.Click “MIDI File+Transmit” (or “MIDI File+Export” depending on your 
sampler).
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Depending on which sampler you use, the following two steps will happen in either 
order:

• A regular file dialog box appears allowing you to position and name the 
MIDI File (we will later use this file to play back the loop). Save the file.

• The slices get transmitted to the sampler (if it is an external instrument) 
or a file dialog appears asking you where to put the files needed for the 
sampler (if it is installed inside your computer). 
For details, see page 116.

Now we are actually done with ReCycle for a while. Let’s start using the stuff that 
the program produced for us.

1. If the sampler is inside your computer you will need to load the instru-
ment by using software that came with the sampler. If the sampler is ex-
ternal, you will only need to make sure that the “Program” (or whatever 
it is called) that was created, is selected and that the instrument is receiv-
ing on the MIDI channel of your choice.

2. Launch your MIDI Sequencer and make sure you are also transmitting 
correctly to the sampler (set the MIDI Output and MIDI Channel).
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3. Play your keyboard to check the material in the sampler. You will note 
that each key plays a slice. What was previously one long recording is 
now a number of short snippets spread out over the keyboard. If you play 
the keys chromatically upwards, the loop will be recreated (although 
probably not with perfect timing!).

4. Load the MIDI file you just saved to disk into your sequencer program. 
Set it to output to the sampler and start playback.
The loop will play back as it originally did.

5. Try changing the tempo in the sequencer.
The fact that you can lower the tempo is thanks to the Stretch setting in ReCy-
cle. See page 113 for details.

6. If you want to, you can also try out some editing, rearranging and dupli-
cating the events in the sequencer to customize the loop.

7. In the sampler, try re-tuning samples, altering envelopes, sending sam-
ples to different outputs, panning etc.

Congratulations! You just tried out all the basic capabilities of your new program! 
Of course, there’s a lot more to learn and discover. Please proceed to the following 
chapters to find out about all the capabilities of this amazing program!
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About Sounds and RAM
Whenever ReCycle displays audio in a window, it has to load it into RAM. 

If you want to be able to load a lot of sound files or if you want to have many win-
dows open at the same time you will need to assign the program more RAM. See 
page 30 for more info.

How much audio you can load into the program at one time depends on how much 
RAM you have in your computer (total) and how much of it that other programs are 
currently using. If the program tells you there is not enough memory for a certain 
operation, or if you can’t open an audio file (in any of the supported formats), the 
first thing to try is to quit other programs.

You can open files that are up to five minutes in length, if you have enough RAM 
for it. To open a five minute file (or two files that are two and a half minute long, for 
example) ReCycle has to have access to 26 MByte of RAM.

Mac:

Win:
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Using Open

The Open dialog.

The Open item on the File menu is used to load audio files from the hard disk.

The dialog box is a standard file dialog with some additions.
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File Info

When you select a file in the list, information about file type, size, etc is shown in 
the lower part of the Open dialog.

The File information

Channel Pop-up

This pop-up appears in the Open dialog if the selected file contains more than one 
audio channel. 

Only one channel (mono) at a time can be opened or Played (see below) from the 
dialog. The Channel pop-up therefore allows you to select one of three alternatives:

• “Left” and “Right” access to the corresponding channels in a stereo file.

• “Mix” allows you to mix the two channels in a stereo file into mono, 
when opening the file.
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Play and Stop buttons

When you click the Play button, the selected channel in the selected file will be 
played back. If you wish to stop playback before the file ends, click Stop.

You will not be able to play a file under the following conditions:

• If the file is in a format ReCycle doesn’t support.
• If there isn’t enough memory (RAM) left to load the sample.
• If the sample is longer than ReCycle can handle.

Filetype Selector

• When the top item on this menu is selected, the file list will show all files 
in the directory that are in any of the formats that ReCycle supports.

• When any of the other alternatives are selected, the files list only shows 
files in that format.

Win:
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About The Different File Formats

ReCycle loads 16 bit files with any sample rate.

The table below shows the supported file formats.

Some of the file formats below may contain more than one channel, that is they 
may be stereo or multi channel files. As described above, the Open dialog will then 
allow you to pick one channel or a Mix of both. 

Name Full Name PC Extension Comment

ReCycle ReCycle files RCY The files created when you save in ReCy-
cle. 

Wave Wave WAV The standard Microsoft file format for au-
dio. May contain more than one channel 
and may be in formats other than 16-bits.

Audio IFF
(AIFF)

Audio Inter-
change File 
Format

AIF Apple’s standard audio file format. May 
contain more than one channel and may 
be in formats other than 16-bits.

ReCycle 
Export

ReCycle’s Ex-
port files

REX This is the file format used when exporting 
ReCycle files for use in other programs, 
such as Cubase VST. For more informa-
tion, see page 127.
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In addition, the Macintosh version of ReCycle supports the following two formats:

Using Drag and Drop

ReCycle for Macintosh supports standard Drag and Drop. Proceed as follows:

1. In the Finder, locate an audio file in one of the supported file formats.

2. Drag this file and drop it on the ReCycle Finder icon.
If the program is already running, the file appears in a new window. If it isn’t, 
ReCycle launches and the file opens.

● If the file is stereo or multi channel, the first (left) channel will be used. If you 
need to specify a channel, use “Open” instead of drag and drop.

Name Full Name Comment

SD I Sound Designer 1 An older Digidesign file format not used 
very much nowadays. 16 bit, mono.

SD II Sound Designer II The current Digidesign file format. At least 
16 bits. May contain more than one chan-
nel.

Mac:

Mac:
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Launching from Files

If you associate the “RCY”, “WAV” or “AIF” file formats with ReCycle you can 
double click on files to launch ReCycle and open the file.

● If the file is stereo or multi channel, the first (left) channel will be used. If you 
need to specify a channel, use “Open” instead of double clicking on a file.

Win:
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Receiving Audio from the Sampler

If you have an external sampler connected to the computer, ReCycle can receive the 
audio directly from it.

1. Make sure the sampler is selected at the bottom of the ReCycle Sampler 
menu.

2. Select “Receive...” from the Sampler menu.
A dialog appears. Its exact appearance depends on which sampler you have.

The Akai S3000 Receive dialog.

3. In the dialog box you will find a pop-up which allows you to select a sam-
ple in the sampler.

4. Clicking Receive transfers the sample into the computer and opens it in a 
new window.
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If the “There will be a very short slice...” dialog appears

If you Open or Receive a sample, and there is no loop setting, or the loop start is 
just at the beginning of the sample, a dialog appears suggesting you should let the 
program move the Left Locator to the first slice marker. This is to avoid very short 
slices at the beginning of the sample. We recommend that you click “Fix” unless 
you have good reason. See page 102 for more information on setting Locators.
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Window Overview
Tools Play Length Settings Tempo SettingsOverview

Waveform Slice MarkersMagnification Control Sensitivity FaderLocatorLocator
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Window Title

The window title displays three things:

• The name of the file.
• The sample rate at which the file was recorded  (see page 117 for details 

about sample rates).
• A text that indicates if the file hasn’t been saved yet.

Handling Windows
You can Open or Receive as many loops as RAM permits, and they will each ap-
pear in a window.

• For more information about window handling, see the documentation that 
came with your computer.

• ReCycle’s Windows menu contains a list of the currently open windows. Se-
lecting one makes that window active.

• The Close item on the File menu closes the active window.
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Toolbox

The Toolbox is located in the upper left corner of the window. By clicking any of 
the tools you select it. Below follows a brief description of what the tools do. De-
tailed applications follow later in this chapter and in the following chapters.

Tool Function

Arrow Used to select Slice markers.

Hide Used to deactivate slices by clicking on their markers.

Lock Used to lock slices, by clicking on their markers.

Pen This is used to add slices manually.

Arrow Tool Hide Tool

Pen ToolLock Tool
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Magnification, Song Position and Scrolling

The Magnification Indicator

If you click or drag in the magnification indicator, the amount of zoom changes. 
Furthermore, the indicator will always show the current magnification.

Using The Magnifying Glass

Zooming in

1. Hold down   [Command] (Mac) / [Control] (Windows).

2. Move the mouse over the waveform area or the thumbnail overview (the 
small waveform above the large one).
The pointer turns into a magnifying glass.

• Click once in the waveform.
The view is zoomed in one step. The position you clicked at will be centred in 
the window.
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Zooming out

• Zooming out is done the same way as zooming in, except you also hold 
down the [Option] (Mac) / [Alternate] (Windows) key.

The Zoom in and zoom out tools.

Using a Zoom rectangle

To select a certain area to zoom in on, proceed as follows:

1. Hold down [Option] (Mac) / [Alternate] (Windows) and press and hold 
the mouse button in the waveform display.

2. Drag to make up a selection rectangle.

3. Release the mouse button.
The selected area will now fill the entire window.

Zooming in on a certain area.
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Magnifying using the Thumbnail Overview

• The method of making up a rectangle with the [Command] key (Mac) / 
[Control] key (Windows), described above, can also be used in the 
thumbnail overview.
This changes the zoom factor of the main waveform, not of the thumbnail it-
self.

Zooming in using the thumbnail.

Magnify to Fit

If you select Magnify To Fit from the Options menu, the display will zoom out so 
that the entire loop fits the window.

Position

When you play back, the current position is indicated by a line travelling across the 
waveform.
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There’s an on/off setting on the Options menu called Scroll During Playback. If this 
is activated and you are zoomed in, the waveform display will automatically scroll 
to always display the part of the loop that is currently played.

A dotted rectangle in the thumbnail overview indicates which area of the waveform 
is currently displayed in the waveform display.

The thumbnail overview shows you which part of the waveform is displayed.

The Scroll Bars

The scroll bars can be used to scroll the view of the waveform.

Scrolling using the Thumbnail

When zoomed in on the waveform, the Thumbnail Overview will display a dotted 
rectangle indicating which part of the waveform is now shown in the main wave-
form display. This rectangle can be dragged sideways, which scrolls the waveform 
display.

Dragging the Thumbnail rectangle.
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Waveform Color
You can design the color of the waveform yourself, by selecting Waveform Color 
from the Options menu. 

This brings up the standard Apple Color Picker.

This brings up the standard Windows Color dialog.

The Edit menu
• The standard Edit menu items, Undo, Cut, Copy, Paste and Clear are not used 

by ReCycle and are therefore always greyed out.
• Select All and Invert Selection are explained on page 100.

Mac:

Win:
ReCycle 1.6 - The ReCycle Window Page  81 



7

Playing Audio 7



Audio Quality
ReCycle plays back audio directly from your computer, using the sound capabili-
ties of your specific computer (see the Installation chapters for more details).

● Please note that the quality of the sound during direct playback from the com-
puter may not be immaculate, depending on what hardware you are using. 
However, this does not reflect the final audio in the sampler, since this always 
maintains highest possible quality.

Playing the entire Loop
There are two ways to play the entire loop:

• Press [space bar].

• Click the Play button.

The Play Button
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Auditioning Slices
When you move the mouse over the waveform area, the pointer turns into a speaker 
icon.

When you click with the speaker tool on a slice (a section of waveform between 
two slice markers), it plays back. The “hot-spot” (the part of the pointer that you 
aim with) is indicated by a cross. Click again to stop (even if you don’t, playback 
automatically stops at the end of the slice).

The cross indicates the hot-spot in the speaker pointer.
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Setting the Volume
On the Options menu you will find an item called Volume. This brings up an hier-
archical menu with volume settings from 0 to 7.

The Volume menu.

The Volume setting is used to control the volume of the audio coming out of ReCy-
cle.

The setting is relative to your Macintosh Sound Control Panel settings, to allow you 
to balance the sound from ReCycle with that from other applications.

Mac:
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Using Sensitivity
Most of the time when working with ReCycle, you will want to cut your loop up 
into slices. A slice is a section of the waveform, from one slice marker to the next.

When you load or receive a loop, ReCycle analyzes it to determine where slice 
markers should appear (where the individual sounds in the loop are).

The Sensitivity fader is then used by you, to set the overall amount of slices. The 
higher the fader, the more slices you will get. And, the more slices you have, the 
smaller entities ReCycle will cut the loop into, when you transmit it.

For more information, see page 99.

As described below, the quickest way to get a good selection of slices is most often 
to set the slider roughly, maybe a little too far up, and then use the Hide Tool to de-
activate any slices you don’t need (see later in this chapter for details on the Hide 
Tool).

The number below the fader represents the current position of the fader, where 0 is 
all the way down and 99 all the way up.

A slice marker
A slice
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Setting Sensitivity using the Keyboard

• If you know you need a specific number, click in the number box below 
the fader, type in the number you want and press [Return] or click out-
side the number box.

• You can also type a number on the typewriter part of the keyboard, di-
rectly, without clicking on the number first.
This can be used to quickly give the fader a rough setting. If you hit “1” it gets 
set to “11", if you press “2” it gets set to “22” etc.

• You can use the [+] and [–] keys to “nudge” the fader up and down.
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Using the Hide tool
You might run into situations where there are too many slices on the screen. You 
could of course pull down the Sensitivity fader to get rid of the slice markers you 
don’t want, but then other slice markers could disappear too, and this might not be 
desirable.What you need to do in a situation like this is to “Hide” an individual 
slice, and this is just what the Hide Tool lets you do: When you select the Hide Tool 
and click on a slice marker it gets diminished and its line disappears.

Before and after Hiding a slice marker.

To try the effect of hiding, proceed as follows:

1. Click on two adjacent slices which play one sound each.

2. Hide the marker that divides the two slices.
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3. Click again to audition.
You will hear that what was previously two slices is now one slice.

Hiding several Slices at the same Time

If you have several slices selected (see below) they will all get hidden when you 
click on one of them.

Clicking on one of the selected slices...

... hides all of them.
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When do I use the Hide tool?

You will use the Hiding tool when you have a situation like the one below.

In the example above, the fader had to be set fairly high to get the number of slices 
you see. But raising Sensitivity led to one unwanted slice, splitting a sound in two.

After Hiding the unwanted slice.

This slice is most
probably not wanted.
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How do I find unwanted Slices?

Our most important tip is this: Always click on each slice to hear what they actually 
play.

Another good practice is to increase magnification slightly and scroll through the 
slices to look for sounds that have been split unnecessarily. 

For optimal results, combine the two techniques above.
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Using the Lock Tool
The Lock tool is essentially the opposite of the Hiding tool. If you lock a slice, by 
clicking on its marker with the Lock tool, it will stay even if you pull the Sensitivity 
fader down all the way.

If a slice is locked...

...it will stay even if you pull the Sensitivity fader down.
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Locking several Slices at the same time

If you have several slices selected (see below) they will all get locked when you 
click on one of them.

Clicking on one of the selected slices...

...locks all of them.

When do I use the Lock tool?

If you got a good set of slices by just using the Sensitivity fader, but discover that in 
one or two places you hear two sounds when you click on a slice, then it is time to 
bring out the Lock tool.

1. Find the place where you hear two sounds when auditioning, and zoom 
in on it if needed.

2. Make a mental note of the current fader setting (look at the number and 
memorize it).
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3. Pull up the sensitivity fader to get a slice between the two sounds.

4. Audition to make sure you got what you wanted.

5. Lock the new slice.

6. Pull down the sensitivity fader to the original setting.
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Adding Slices manually

● Before adding slices manually, make absolutely sure the slices found by the 
analyze algorithm don’t suffice. The program is very good at finding slice 
points, and the points found by the program often work better – for example 
for tempo changes – than the ones that you can add manually.

1. Identify the area where you need a slice, and zoom in very close on it.

2. Select the Pen Tool.

3. Move the pointer over the waveform display.
A vertical line moves across the waveform. This line indicates where the slice 
will appear when you click. The line snaps to zero crossings in the waveform 
(positions where the amplitude is zero), so manually added slices won’t intro-
duce any clicks or pops. If the amplitude is zero for a period of time, the line 
will move continuously over this area.

The vertical line snaps to zero crossings.
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4. When you have found the correct position, click with the Pen.
The slice appears.

The following rules apply to manually added slices:

• To “remove” an added slice, Hide it as any other.
• Manually added slices are locked. They will therefore not disappear when 

you lower Sensitivity.
• If you unlock a manually added slice and pull the sensitivity fader down 

lower than halfway (below 50), it will disappear, just as other slices.

Adding a Slice at any position

• If you hold down [Option] (Mac) / [Alternate] (Windows), the snap to 
zero crossing is disabled and you can add a slice at any position.
We do not recommend that you do this unless you have very good reason, 
since it can introduce clicks and pops in the sound during playback.

When do I add Slices manually?

As described above, we suggest you only add slices manually when the program 
fails to find one at a position where you need it. In other words, you will need to 
add a slice manually when you click on a slice and hear two sounds, one after the 
other, even though the Sensitivity fader is set to 99.
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Where do I add the Slice?

Zoom in far enough for the display to clearly show how the cursor jumps between 
zero crossings. Try to find the first position before the beginning of the sound. If 
you make a mistake, simply hide the slice you created and add a new one at another 
position.
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How many Slices do I need?
Well, it depends...

• If you have Transmit As One Sample (on the Sampler menu) turned on, you 
don’t need any slices at all, except when you move the Locators to find a 
good loop point.

• If you plan to edit the loop a lot in your MIDI sequencer, you should try to get 
one slice per sound in the loop, or in some situations (very busy sections for 
example), one slice per eighth note or sixteenth note (to simplify editing in the 
sequencer).

• If you want to create a groove, you should try to get approximately one slice 
per eighth note, sixteenth note or whatever the loop requires.

• If your main reason for slicing the loop is to change the tempo, you generally 
need as many slices as you can get, but never more than one per individual 
sound in the loop. This is to retain the “integrity” of each sound when played 
back from the sequencer.

● Please remember that your ears are always the best judge. The auditioning 
tool is vital for finding a good selection of slices. Since transmitting to the 
sampler and trying the loop out in the sequencer is so quick and easy, do not 
hesitate to go back, change the slicing and re-transmit.
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Selecting Slice Markers
Slice markers need to be selected for some operations, like Silence Selected (see 
page 112 and page 139):

• Selecting is only done with the Arrow Tool.

• You can select one marker by clicking on its triangle symbol.

• If you hold down [Shift], you can click on more markers to select them. 
Clicking again with [Shift] pressed deselects a marker.

Selected and unselected markers

• You can make up a selection rectangle by pointing between slices, press-
ing the mouse button and dragging left or right. When you release the 
mouse button, all the slices inside the rectangle will get selected.

Making up a rectangle like this...

...selects these markers.
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• You can use the Select All item on the Edit menu to select all markers.

• If you have a selection of markers, you can invert the selection by using 
“Invert Selection”, also on the Edit menu. After this operation, the mark-
ers that were previously selected are now deselected, and vice versa.
This is mainly useful together with Silence Selected, see page 112 and page 
139.

Before and after using “Invert Selection”

• You can deselect all markers by clicking between two markers on the 
ruler.
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Left and Right Locator — Setting the Loop

By dragging

The left and right Locators can be dragged to set the Loop during playback.

• If you have no slices at all (if the Sensitivity fader is all the way down), 
the Locators can be positioned freely.

• If there are any slices visible, the Locators snap to the lines.

• If you want to position the Locators freely, even though you have slices, 
hold down [Option] (Mac) / [Alt] (Win) while dragging a Locator.

By clicking

• To set the Left Locator, hold down [Shift] and click on the ruler.

• To set the Right Locator, instead hold down [Command] (Mac) / [Control] 
(Win) and click.

• Normally, the positions snap to the closest slice point, but if you also 
hold down [Option] (Mac) / [Alt] (Win) when you click, you can set the 
Locator at any point.
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Use the Slices when setting Loop Points!

When trying to find a good loop point, use snap to slices if at all possible. If you 
don’t seem to get a good loop point that way, try raising the Sensitivity fader to get 
more slices and try again.

When – and only when – you can’t find a good loop point in this way, zoom in and 
adjust the Loop positions with [Option] (Mac) / [Alternate] (Win) pressed.

What are the Locators used for?

The Locators are of course used to define the loop you get during playback. But 
they also have other purposes:

• ReCycle uses the Locator positions when calculating the tempo of the Loop.
• When transmitting audio to the sampler, only the part between the Locators is 

actually sent.
• When you create MIDI files, only the section between the Locators is taken 

into consideration, as with the transmitted audio above.
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Tempo, Time Signature, Bars and Beats
Many of the operations in ReCycle require you to specify how long the loop be-
tween the Locators actually is, meter-wise. This information is then used to calcu-
late the tempo of the loop.

Time Signature

The Time Signature option allows you to choose between a few of the more com-
mon Time Signatures. If none of them fit your purpose, you can still “assemble” a 
correct Time Signature using the Bars and Beats settings, see below.

Bars and Beats

The Bar field and Beat pop-up are used to specify the length of the loop. Lets ex-
plain this by example:

Actual Loop Length Set “Bars” to: Set “Beats” to:

One bar 1 0

Two bars 2 0

Half a bar in 4/4 0 2

One and a half bar in 6/8 1 3
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As stated above, you can use Bars and Beats to “create” some unusual Time Signa-
tures:

Tempo

When the Left and Right Locators are set, and the correct Time Signature and loop 
Length (Bars and Beats) are specified, this field will show the tempo of the loop. 
This tempo is inserted into the MIDI Files that ReCycle creates, if “New Tempo To 
Pitch” on the Sampler menu is turned off. See below and page 136.

New Tempo

If you click in this field you can type in a new Tempo. Finish by pressing [Return] 
or clicking outside the box. This Tempo will be used in MIDI Files if “New Tempo 
To Pitch” is activated, see page 115 and page 145.

Actual Loop Length Time Signature  Bars Beats

One bar in 5/4 4/4 1 1

Two bars in 7/4 4/4 3 2

One bar in 9/8 6/8 1 3
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Selecting a Sampler to Transmit to
To route the Receive and Transmit functions to a particular sampler, select it from 
lower section of the Sampler menu.

An Akai S3000 selected.

You can have several samplers connected, either of different types or of the same 
type, but only one at a time can be selected.

Two S3000s found by the program.

You can switch samplers while you are working with the program, which allows 
you for example to Receive a sound from one sampler and Transmit it to another.
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Transmit/Export and Memory
The program needs free memory in the computer for Exporting and Transmitting. 
In a worst case (withs Stretch set to 100%) it needs twice the memory of the longest 
slice. This means that if you have “Transmit As One Sample” turned on and use 
high Stretch factors, you need to make sure you have enough memory left, when 
you Transmit.

For more information, see page 30 and page 64.
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Transmit Options

On the Sampler menu, you will find a number of Transmit settings (or “options”, 
some of which can be turned on/off and others which can be set to a certain value.

Each document has its own settings. If you are working with a lot of windows, be 
sure to check that the settings are correct before you Transmit.

The settings only come into effect when the audio is actually being transmitted to 
the sampler, or when the MIDI File is being created. They have no effect on play-
back in ReCycle. But if you want to hear a preview of the effect they have, you can 
use the “Transmit To New Window” option described below.

The settings are also saved to disk with the file when you Save.

You will find applications of all the options described below, on page 131 and on-
wards.
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Transmit as One Sample

Deactivated

When Transmit As One Sample is turned off, the audio gets sliced into individual 
samples when transmitted, and the MIDI files created will contain one note for each 
of those slices.

This is the preferred mode if you want to use your MIDI sequencer to edit the loop, 
change its tempo or use the MIDI file as a groove.

Activated

When Transmit As One Sample is turned on, the program will transmit the part that 
stretches from the Left Locator to the Right as one sample. Also, in this mode, the 
MIDI File will only consist of one event, with the length set using the Bars and 
Beats settings.

This mode is mainly useful if you simply want to use ReCycle to find the right 
tempo for a loop, when you want to use the New Tempo feature to tune the sample 
to the right length or when you want to use ReCycle to extract sounds.
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Normalize

With Normalize turned on, ReCycle will permanently change the gain of each slice 
before transmitting it to ensure maximum level. This is to ensure the noise level is 
kept as low as possible during playback.

However, if you transmit a loop as a number of slices, normalizing will disrupt the 
dynamics of the drum loop, since the gain of each slice is changed separately. 
Therefore, normalizing is probably best used when you have Transmit As One 
Sample turned on (in this case the entire loop is treated as one long sample when 
being normalized) or when you use the program to extract individual sounds.

● Normalize can’t do miracles. If your recording contains unwanted noise, nor-
malizing will increase the noise level together with the other audio material.
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Silence Selected

When this flag is turned on, the slices that have selected markers will be silenced in 
the final audio.

When Silence Selected is turned on, the slices which have selected markers...

...will be replaced by silence (indicated in grey) in the final audio.

This feature is probably best used when Transmit As One Sample is turned on, to 
silence individual sounds in a longer sample. An application of this is found on 
page 139. It can also be used to simply skip unwanted sounds, when slicing.

But, Silence Selected works even if Transmit As One Sample is turned off. In this 
case, the selected slices will simply be skipped, both when transmitting to the sam-
pler and when creating MIDI Files. This will then create “gaps” in the sampler's 
keyboard map and a corresponding “gap” in the MIDI File.
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Stretch

This feature is used when you know you might want to lower the tempo of the loop 
in your MIDI sequencer.

How Stretch works

When you slice up a loop and play it back from your sequencer, each sample will 
play in succession. At the original tempo, one slice will end exactly where another 
starts.

As you understand, when you then lower the tempo, there will be small gaps be-
tween the slices, which disrupts the flow of the audio.

Stretch is used to add an extra tail of audio to each slice, to lengthen it. This tail is 
derived from the natural decay of the sound. This extra tail of sound then fills out 
the gap between the slices when the tempo is lowered.

● Please note that the attack of the sound is not affected in any way. 

The Amount of Stretch

To set the amount of stretch, pull down the Sampler menu, position the mouse over 
the word Stretch and then select a value from the hierarchical menu that appears.
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The values on the menu tell you how much longer the entire sample will be after 
stretching. If you select the largest value (100%), for example, the slice will be-
come twice its original length when being transmitted to the sampler.

To decide how much stretch you need, try to make a rough estimate of how much 
you need to lower the tempo, in percent. Then select the next higher value from the 
menu. If for example you know that you will need to lower the tempo by approxi-
mately 12%, select a stretch factor of 15%. If that doesn’t work as intended, change 
the Stretch setting and re-transmit the slices.

● Please note that just setting a Stretch factor does nothing. It is only when you 
transmit the slices that the audio actually gets stretched.

Stretch is not Time Stretch!

Again, the Stretch feature doesn't lengthen the whole slice, it only adds a portion of 
sound at the end of it. You can use the “Transmit To New Window” feature to 
roughly try out the effect of stretching, as it would turn out in the sampler. But do 
not expect as good results from this, as when you transmit the loop to the sampler.
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New Tempo to Pitch

This setting is used when you want to make a loop fit a certain time span by chang-
ing its tuning (pitch) rather than by slicing it.

In the dark ages, before ReCycle, the only way to make a loop fit a certain tempo 
was to either use a Time Stretch program such as Steinberg’s TimeBandit or Wave-
Lab, or to change its tuning until it fitted an existing song. This feature lets you per-
form exactly that option, but in a much more convenient way than by twiddling the 
knobs on your sampler..

Let’s say you have set up a loop and have had ReCycle calculate the tempo of it to 
be 100 BPM (beats per minute). Your Song is in 110 beats per minute. So you type 
in 110 as your New Tempo, turn on “New Tempo to Pitch” and transmit the sample 
back to the sampler. 

When you do this, ReCycle will reach into your sampler and raise the tuning setting 
for this particular sample by “0.65” semitones, so that when you press a key, the 
loop will fit 110 BPM exactly (no, you don’t want to know about the mathematics 
behind this, trust us!).

More info on page 145.
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The Transmit dialog(s)
The top menu item on the Sampler menu shifts name depending on which sampler 
you have selected. For external samplers it is called “Transmit to...” and for internal 
samplers (for which the program saves audio files on your computer’s hard disk) 
the item is called “Export to...”.

The Sampler menu when an S3000 is selected.

The Transmit dialog when an Akai S3000 is selected.
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Exactly how the dialog looks depends on the selected Sampler, but there are a few 
standard items you will most often find there:

Sample rate

ReCycle can handle samples with any sample rate and can convert samples from 
any rate to any other.

Title shows inherent rate

When you Open or Receive a sample, its inherent sample rate is displayed in the 
window title.

A sample recorded at 44.1 kHz.

Available rates

In the transmit dialog, a number of sample rates can be selected from a pop-up. Ex-
actly what options are available depends on the sampler selected.

• If possible, the sample’s inherent rate is suggested.
If, for example, the sample was recorded at 48 kHz, this will be the suggested 
sample rate in the Transmit dialog.
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• If the sample’s inherent rate is not supported by the sampler, the next 
higher rate is suggested.

• In addition to the above, a number of other sample rates can be selected 
from the pop-up in the Transmit dialog.
If the sampler only handles a few sample rates, they can all be selected. If the 
sampler supports many rates, the most commonly used ones (or the ones clos-
est to these) are available. Those most common rates are 11.025kHz, 
22.05kHz, 32kHz, 44.1kHz and 48kHz.

The S-3000, for example, only supports 22.05 and 44.1kHz sample rates.

When is sample rate conversion performed?

If you transmit, and the sample rate set in the Transmit dialog is not the same as in 
the window title (the sample’s inherent rate), a sample rate conversion will be per-
formed during the transmission.
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When should I change from the suggested sample rate?

Lowering the sample rate will make the samples occupy less memory in the sam-
pler, but it will also lower the fidelity of the recording (less high frequency material 
will be present).

On the other hand, increasing the sample rate will not raise the fidelity of the sam-
ple in any way. It is therefore not recommended to convert from a low rate to a 
higher one, unless it is required by the sampler.

Templates

When ReCycle sends audio to your sampler it will put the samples it creates in a 
“container” which holds all the samples and their mapping on the keyboard. This 
“container” may be called a Program, Instrument, Patch or similar, all dependent on 
the naming used by the sampler manufacturer. For now, let’s call it a Program.

There are a number of settings in the Program which may or may not be of impor-
tance to you. 

• If the settings are not important to you, you don’t need to use templates, you 
can switch the Template function off or use the Default option in the Transmit 
dialog. ReCycle will simply create as simple a Program as possible. You can 
then change this Program’s setting by using the controls on the sampler itself.
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• If you do need special settings, you use Templates. You might for example 
want the first slice to appear on a certain key, you might want to have all sam-
ples play to a certain output, you may want the Program to receive on a cer-
tain MIDI Channel etc. Proceed as follows:

1. On the sampler, manually create a Program with all your preferred set-
tings.
Make sure the first sample in the Program’s keyboard map is positioned where 
you want the first sample in the keyboard map created by ReCycle.

2. Save this Program to disk (using the sampler’s regular file saving func-
tions), for later use, but make sure it still resides in the sampler’s internal 
memory.

3. In the ReCycle Transmit dialog, activate this Template.
Exactly how this is done depends on the sampler. If it is external you can se-
lect the Program from a pop-up menu in the dialog. If ReCycle saves the data 
on to your computer’s hard disk, then you select a disk file as your template.

4. Transmit/Export the Program.
A new Program is created in the sampler. It will get all the settings of the Tem-
plate. The first slice will appear on the same key as where the first sample in 
the Template was.
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● If you use exactly the same name as the Template, the new Program will re-
place the Template.

Name

Using this field you can specify a name for the Programs you are about to create in 
the sampler.

• If the sampler is external you will be able to specify the name directly in the 
dialog. Any characters not supported by the sampler will be replaced by 
spaces, and the name will be truncated to fit the length of the names in the 
specific sampler.

• If the sampler reads files from your computer’s hard disk, a regular file dialog 
will appear when you click one of the Export buttons (see below), allowing 
you to name the Program disk file.

• The actual slices that the Program contains will in both cases get names de-
rived from the Program name, with a number added at the end. For example 
BigDrums#01, BigDrums#02, etc.

Transmit/Export

This button creates a Program and samples for it as described above, without creat-
ing any MIDI File.
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MIDI File + Transmit/Export

This button will make two things happen (in which order these two things occur de-
pends on which sampler you are using):

• A file dialog appears, which allows you to create a MIDI File on your 
computer’s disk.

• Programs and samples are created as described above.
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The New Window option
One of the “samplers” on the sampler menu is called “New Window”. When this is 
selected, the Transmit/Export item on the Sampler menu is called “Transmit To 
New Window”.

When you “Transmit To New Window”, you will get a preview of what would have 
been sent to the sampler. If Transmit As One Sample is turned off, each slice ap-
pears in its own window; if Silence Selected is turned on the selected slices will be 
silenced; if Stretch is set to anything but Off, each slice will be stretched etc.

The audio you get in the new window(s) is the same as you would have been get-
ting had you Opened or Received it. It can be used – as mentioned above – as a pre-
view of what you will be getting in the sampler, or as a basis for a new piece of 
audio to Transmit or Export to disk (see below).

Here are few examples of what “Transmit To New Window” can be used for:

• To extract a shorter part from a long sample.
• When you use Silence Selected, to check that you have selected the right 

slices.
• To check if stretching a slice comes out as intended and to find the ideal 

Stretch factor.
• To see  see exactly how much Normalizing does to a sample.
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Saving ReCycle documents
If you have Opened an audio file and worked on the slices and other settings, you 
can save it as a ReCycle document. 

• Saving is done using regular “Save” and “Save As” methods.

• ReCycle files can be opened just like any other, see page 65. The only dif-
ference is that no analysis needs to be performed, since the analysis data 
is already included in the file.

• On the PC, ReCycle files have the extension “RCY”.

• The ReCycle documents include the following:
• The audio data.
• All the slice points and their status (locked, hidden etc).
• All Transmit options on the Sampler menu.
• The Sensitivity and Length settings.

Saving a ReCycle file has a number of advantages:

• No analysisi needs to be performed, which makes opening files in this format 
faster than other formats.

• In case you want to go back and adjust the slice points after transmitting, no 
work has to be redone if you have saved the file as a ReCycle document.
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Export Sound
This item on the File menu allows you to save all the audio between the Left and 
Right Locator to disk. These files can then be brought into any audio editing or 
playback program that supports any of ReCycle's possible export file formats.

The same logic applies as when Transmitting. This means for example that if 
Transmit As One Sample is turned off, each slice will become a separate file (see 
Transmit To New Window” above for more info).

File Format and Sample Rate

The Export Sound dialog contains two pop-up menus not found in the Save dialog.

• File format. See page 68 for details.
• Sample rate. See page 117 for more info.

The audio files created by ReCycle are always mono, 16 bit.

Exporting requires memory, see page 108.
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Export to to REX format (for Cubase VST)
This feature allows you to export ReCyled files in a format that Cubase VST can 
read.

● Please note that this requires Cubase VST 3.02 or later! If needed, contact 
your dealer for an update.

To ReCycle a file for use in Cubase VST, proceed as follows:

1. Locate the file on disk and open it in ReCycle.
This can be a file you have recorded in Cubase, or it can be a file of any other 
origin.

2. Set up the slices, bar length, time signature and sampler options as de-
sired.
A typical application would be to slice for tempo changes, as described on 
page 136.

3. Select “Export to ReCycle! REX file”, from the ReCycle File menu.

4. Specify a location and name for the file and save it.

5. Switch over to Cubase VST.
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6. Select an Audio Track where you want to import the file and set the Left 
Locator at the position where you want the file to appear.

7. Select "Import ReCycle file", from the Audio menu.

8. Locate the ReCycle export file you just saved, and open it.
Now the following happens:

• The file is added to the Pool.
• A number of Segments are created for the file, each one corresponding to a 

slice in Recycle.
• A Part which will play the file is automatically created on the active Track, 

starting at the Left Locator position.
Now you can play back the ReCycled file in any tempo, as if using a sampler. 
You can also edit it in detail, quantize, etc, for example from the Audio editor.

• If you need to re-import the file into the Arrangement, drag the file item in the 
Pool to the Arrangement, just as any other file. A new Part is then created.

● Please note that the new file will sound very strange if played back in its en-
tirety. It should only be triggered from the Part which has been created in the 
Arrangement. 
Also note that if you ReCycle a file that was already used in the Arrangement, 
you will have two copies of it, one regular and one ReCycled. You might want 
to delete – or at least mute – the original, to avoid confusion.
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Exporting MIDI Files
There are two ways to create MIDI Files with ReCycle:

• By selecting “Export Groove MIDI File” from the File menu.
• By clicking the MIDI File+Transmit/Export button in the Transmit/Export dia-

log (see above for details).

The MIDI Files created are identical in both cases. So why use one or the other? 
Well, normally you will create MIDI Files as a part of the Transmission process (by 
clicking “MIDI File+Transmit/Export” in the Transmit dialog). But if you only 
want to create a MIDI File (for example when using ReCycle to create “groove 
maps”), use Save Groove MIDI File.

In either case you are prompted with a regular File dialog where you can specify a 
name and location for the file.

ReCycle always creates MIDI Files of type 1. However, they only contain one 
Track plus a Tempo Track.

Templates and MIDI Files

• If you create a MIDI File from the Transmit dialog, the position of the first sam-
ple in the Template affects the transposition of the MIDI File (so that the file 
plays the right samples).

• If you use “Save Groove MIDI File” the first note is always C3.
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“Transmit As One Sample” and MIDI Files

• If Transmit As One Sample is turned off, the MIDI File will contain a number 
of short events, each triggering a slice in the sampler, to recreate the loop.

• If Transmit As One Sample is turned on, there will only be one long event 
which triggers the entire sample.

“New Tempo To Pitch” and MIDI Files

• If New Tempo To Pitch is turned off, the MIDI File will get the tempo calcu-
lated by ReCycle (displayed in the “Tempo” field in the ReCycle window).

• If New Tempo To Pitch is turned on, the MIDI File will have the Tempo set in 
the “New Tempo” field in the ReCycle window.

“Silence Selected” and MIDI Files

Silence Selected only affects the MIDI File if Transmit As One Sample is turned 
off, as described on page 112. In this case, there will be “missing” events in the 
File, namely those which were set to be silenced (the selected ones).

“Stretch” and MIDI Files

The Stretch setting has no effect on the MIDI Files created by ReCycle.
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Which Samples will work?
All. But although ReCycle does a very intelligent analysis of the sample to find the 
individual “hits” or “sounds” in it, the sample has to meet some basic criteria to en-
able the automatic algorithm to find all the individual sounds:

• Each sound in the sample must have some kind of perceivable attack. You will 
for example run into problems with legato playing on a flute.

• The sample must be adequately recorded. Weak sounds recorded at very low 
volumes might not get all the slices they should.

• The program might have problems with sounds drowned in smearing effects, 
like extremely thick chorus or short repeating delays.

Please remember that you always have the possibility to add slices “manually”.

Using Normalize to increase “readability”

If you have a loop that was very poorly recorded, you might be able to get a better 
recognition by normalizing it before trying to find the slices:

1. Set Sensitivity to 0.

2. Drag the loop points all the way to the left and right, respectively.

3. Set Bars to any value but 0.
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4. Set up the Transmit options as follows:

5. Select “New Window” as Sampler and then select “Transmit To New Win-
dow”.
You will now have a normalized copy of the original file. Raise Sensitivity to 
check if the recognition got better.

Transmit As One Sample On

Normalize On

Silence Selected Off

Stretch Off

New Tempo To Pitch Doesn’t matter
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The Simple Trim
The most basic thing you can do with ReCycle is to set a good loop point for a sam-
ple and then retransmit it to the Sampler, without any slicing or processing.

1. Open or Receive the sample.

2. Raise the Sensitivity Fader until a large number of slices appear.

3. Activate playback and move the loop points until you find a good loop.

4. Make sure the loops starts on a downbeat (sometimes you might decide 
to let the loop start somewhere else but we just want to make sure this 
doesn’t happen by accident).

5. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.
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6. Set up the Sampler Options like this:

7. Select your sampler from the Sampler menu and select Transmit/Export 
or MIDI File+Transmit/Export.
The MIDI File you get will contain one event which plays the entire loop at 
the calculated tempo.

8. Load the MIDI File into your sequencer and set things up so that it plays 
the correct “Program” in your sampler.

9. Repeat the MIDI File in your sequencer, as needed.

Transmit As One Sample On

Normalize Off

Silence Selected Off

Stretch Off

New Tempo To Pitch Off
ReCycle 1.6 - Example Applications Page  135 



Slicing for Tempo Changes
1. Open or Receive the sample.

2. Raise the Sensitivity Fader until a large number of slices appears.

3. Activate playback and move the loop points until you find a good loop.

4. Work on the slices with the Hide and Lock tools until you have one slice 
per sound in the loop.
It is important that no slice plays two consecutive sounds, so click on them 
one at a time to check. 

5. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.
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6. Set up the Sampler Options like this:

7. Select your sampler from the Sampler menu and select MIDI File+Trans-
mit/Export.
The slices get transmitted. The MIDI File you get will contain a number of 
notes which play back the Loop (the slices in the sampler) in its original 
shape.

8. Set things up so that the sequencer plays the new “Program” in your sam-
pler.

9. Load the MIDI File into your sequencer and play it back. Try varying the 
tempo.

10.Repeat the MIDI File in your sequencer, as needed.

Transmit As One Sample Off

Normalize Off

Silence Selected Off

Stretch If you plan to lower the tempo, set this as suggested 
on page 113.

New Tempo To Pitch Off
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Slicing for Editing
If your main goal is to edit the loop, rather than changing its tempo, you may take a 
slightly different approach compared with slicing for tempo changes:

1. Set things up as in the example above.

2. Work on the slices with the Hide and Lock tools until you have approxi-
mately one slice per eighth note, sixteenth note or whatever you need, 
depending on how detailed an edit you want to do.
If a slice plays more than one sound, please remember that you won’t be able 
to edit these two sounds independently. There are occasions when this will be 
perfectly OK though, for example when you just want to shift the order of the 
beats around in the loop.

3. Proceed as from point 5 in the previous example.

4. In the MIDI Sequencer, open the MIDI File for editing. When you move 
slices around, make sure they keep their relative position to the beats, 
eighth notes etc, to maintain the integrity of the timing in the groove.
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Using Silence Selected
Even if you don’t want to cut up a loop in slices, you can still use ReCycle to send 
different sounds in the loop to different outputs. The example below assumes you 
only want to pick out one sound, but the same technique can of course be applied to 
separate as many sounds as you need.

1. Open or Receive the sample.

2. Raise the Sensitivity Fader until a large number of slices appears.

3. Activate playback and move the loop points until you find a good loop.

4. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.
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5. Set up the Sampler Options like this:

6. Work on the slices until they play one sound each when you click on 
them.

7. Select all slice markers which play the same sound, for example the 
snare.

8. If you wish to, select New Window as your “sampler” and transmit the 
loop to a new window. Play it back to check that all snares are silent.

9. Select your actual Sampler from the sampler menu and select Transmit/
Export or MIDI File+Transmit/Export.
The MIDI File you get will contain one event which plays the entire loop at 
the calculated tempo.

Transmit As One Sample On

Normalize Off

Silence Selected On

Stretch Off

New Tempo To Pitch As you like
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10.With the selection still set up as before, select “Invert Selection” from 
the Edit menu.
Now all sounds that are not snares are selected.

11.Transmit the sample again to the sampler, but under another name.

12.Set up the sampler and sequencer so that the two samples are played 
back at the same time. Also set up the sounds to one output each. They 
will together recreate the loop as it was, but the snare will be separated 
to its own output, which means that you have independent control over 
its volume, that you can EQ it separately, that you can add effects to the 
snare only, etc.
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Extracting a Groove
If you think about it, you will realise that all ReCycle MIDI Files are actually tim-
ing maps of how the drums were played in the loop. Many sequencer programs 
have the ability to load MIDI Files and apply their timing to the sequenced parts. 
The terminology used is “Match Quantize” or “Groove”. 

If you use a ReCycle MIDI File as a “groove template”, you can make your se-
quenced parts play back with the timing of the drum loop. For this, you could of 
course use the MIDI File you get when Transmitting slices to the sampler. But, you 
can also create a timing file only, using “Save Groove MIDI File”. Proceed as fol-
lows:

1. Open or Receive the sample.

2. Raise the Sensitivity Fader until a large number of slices appears.

3. Work on the slices with the Hide and Lock tools until you have one slice 
per eighth note or sixteenth note.
In many situations there will be no sound on a certain eighth or sixteenth 
note. There’s not much you can do about this. You can copy another MIDI 
note in the sequencer later, or insert a new one “by hand”. You can also add a 
slice manually, at any position.
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4. Set the Time Signature and length (Bars/Beats) to whatever the length of 
the loop.
The Tempo gets calculated.

5. Set up the Sampler Options like this:

6. Select Save Groove MIDI File from the File menu and save the MIDI File.

7. If you use Steinberg Cubase, applying the MIDI File to existing music is a 
piece of cake. Just Import the MIDI File into an Arrangement and use 
Match Quantize to drag the groove onto a MIDI recording.

Transmit As One Sample Off

Normalize Doesn’t matter

Silence Selected Off

Stretch Doesn’t matter

New Tempo To Pitch Doesn’t matter
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Quantizing Audio
If you have sliced a groove or other recording, you can apply quantizing to it in the 
sequencer, if you like.

● When Transmitting, use at least a small amount of Stretch, to avoid the gaps 
between slices that might otherwise occur.

Please note that if you have two sliced loops in a Cubase Arrangement, applying the 
timing of one of them to the other is really easy. Just use the Match Quantize tool to 
drag one of the Parts on top of the other (see the Cubase manual for details).

If you don’t like what you get, Undo the Quantize, and try this the other way 
around for example.
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Using New Tempo
If you have a Song which plays in a different Tempo from that of the loop, you can 
of course slice the loop in order to change its tempo without altering the pitch. This 
is described under the earlier heading “Slicing for Tempo Changes”. However, if 
you’d rather not slice the loop but instead use the tuning setting in your sampler to 
make the loop fit a certain tempo, proceed as follows:

Set everything up as in the previous example, but before selecting Transmit/Export, 
perform the following steps:

1. Turn on “New Tempo To Pitch” on the Sampler menu.

2. Click in the “New Tempo” field in the ReCycle window, type in the de-
sired Tempo and press [Return].

3. Transmit to sampler and create a MIDI File.
The sample will be tuned to match the tempo.
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Extracting Sounds
This can be used to extract single sounds (snares, hi-hats etc) from a loop or other 
recording). It can also be very useful if you have recorded more than one drum loop 
into a file and want to save each one as a separate file. 

1. Open or Receive the sample.

2. Raise the Sensitivity Fader until the desired number of slices appears.

3. Work on the slices with the Hide and Lock tools until you get the sounds 
you want when you click to audition.
In the case of the “multi-loop” file outlined above, this would mean one slice 
per loop.

4. Set the Loop point to enclose the first and last sound you want from the 
loop.
This might mean unwanted sounds are transmitted, but these can always be 
deleted in the sampler. Or you can use “Silence Selected” to prevent some 
slices from being sent.

5. Set “Bars” to any value but “Off”.
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6. Set up the Sampler Options like this:

7. Select your Sampler from the Sampler menu and select Transmit/Export.
The slices get transmitted. Alternatively, you can use Export Sound to save 
each slice as a file.

Transmit As One Sample Off

Normalize On

Silence Selected Off or On (see point 4 above)

Stretch Probably Off, but you could use Stretch to lengthen 
the sounds and give them a more natural decay.

New Tempo To Pitch Off
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Using Loops with unusual length or cutting
Sometimes you don’t have a full bar of a loop. Set up the loop and the Bars and 
Beats fields for as much as you have. Then slice the loop. Finally, use your se-
quencer’s editing capabilities, on the MIDI notes, to recreate the missing parts.

You will also encounter situations where the best loop doesn’t really start on a 
downbeat. It might for example happen that you get the best loop when you posi-
tion the Left and Right Locator at the last quarter note of two measures.

If this happens, you can fix it in Cubase, by cutting the last quarter note of the MIDI 
Part and pasting it in at the beginning, to position the downbeat correctly. If you 
don’t want to slice the loop completely, at least allow a slice at the downbeat (the 
Lock tool is ideal for this). Then, repositioning that last quarter note to the begin-
ning of the loop will be very easy. 
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Appendix A

Installing and Using OMS (Macintosh 
Users Only) A



Introduction
MIDI communication in ReCycle for Macintosh is handled by OMS, the Open 
MIDI System. This ensures that ReCycle will fit into your current MIDI System. It 
allows you to use ReCycle with multi-port interfaces such as the Mark of the Uni-
corn MIDI Time Piece and Opcode Studio 4 and 5. It also ensures compatibility 
with future MIDI hardware and software for the Macintosh.

Do I Need to Install OMS?

You only need OMS in the following situations:

• If your sampler requires MIDI communication with ReCycle.
• If, for one reason or another, you don’t want to use SCSI for sample data trans-

fer.

OMS Documentation included!
Included in this package, you will find the full OMS documentation. This docu-
ment is the complete OMS manual, in electronic format.
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Installing OMS
This section is for those of you who don’t already have the latest version of OMS 
installed on your computer. In this text we assume the following:

• You have one MIDI interface connected to one of the serial ports on your 
Macintosh. 

• You have no MIDI Patcher in your system.
• You do not need to use the MIDI Manager.

If you don’t fit the above description setting up OMS is slightly more complicated. 
Please refer to the OMS documentation.

Setting Up

• Connect the MIDI Interface to your computer.
If you have a multi-port interface like the Opcode Studio 4 and 5 or the Mark 
of the Unicorn MIDI Time Piece, there are probably a number of additional 
steps you need to perform at this point to make it work properly with your 
computer (install software, set switches etc). See the documentation that 
came with the MIDI interface, for details.
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Setting Up

1. Connect the sampler to your interface, both ways!
For ReCycle to work, the MIDI Out on the sampler must be connected to a 
MIDI In on the interface, and the MIDI In on the sampler must be connected 
to a MIDI Out on the interface.
If you have a multi-port interface, you should use the same port for MIDI In 
and Out. For example if you connect the MIDI Output of the sampler to MIDI 
In 3 on the interface, you should connect the sampler's MIDI In to the inter-
face's MIDI Out 3.

2. Turn on or activate the interface, if needed.

3. Turn on your MIDI system.

Installing OMS

1. Locate the OMS Installer file and double click on it.

2. Follow the instructions on screen.

For more information on the OMS installation, see the OMS documentation in-
cluded in this package.
ReCycle 1.6 - Installing and Using OMS (Macintosh Users Only) Page  152 



Launching OMS Setup

After installation, you have a new application on your hard disk, called OMS Setup.

1. Double click on the OMS Setup application.

 

2. If the following dialog box appears, we recommend that you disable Ap-
pleTalk and make sure your interface is active.

The most common reasons for using AppleTalk are:

• You have a laser printer connected to the Printer port.
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• You are using file sharing with other Macintoshes.

See the OMS documentation for more information.

3. If you have chosen to turn off AppleTalk, yet another dialog box appears. 
Follow the instructions and click OK.
You can later activate AppleTalk again from the Chooser, if you need it.

4. Follow the instructions on screen until you have a Studio Setup window 
with at least a symbol of your MIDI interface.
Possibly, OMS has also detected all your connected equipment and displays 
symbols for it in the window.
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Setting up OMS for ReCycle
This applies whether you just installed OMS or whether you already had it installed 
in your computer.

Defining your sampler as a Device

If your sampler is not already defined in the OMS Setup window, you need to do 
this, manually.

1. Launch the OMS Setup application.
Your current OMS Setup appears.

2. Click on the interface symbol, to select it.
In the example below, a standard MIDI interface is selected.
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3. Select New Device from the Studio menu.

4. Set up the Manufacturer and Model fields for your specific sampler.
OMS doesn’t “know” about all the different samplers that exist, so for some 
you have to specify “Other” as the Model, and type in the exact name in the 
Name field. 

● If you have chosen “Other” for model, please make sure you type the name 
correctly!

In the example below, an S2800 is specified in this way.
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Setting the Port number for Multi-port interfaces

If you have a multi-port interface like the Opcode Studio 4 and 5 or the Mark of the 
Unicorn MIDI Time Piece, you need to specify to which port the sampler is con-
nected:

1. Select a port number by clicking it.

2. Type the number of the port pair to which that MIDI device is connected.

3. Press [Return].

In this example, the S1000 is connected to Port 3.
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Additional Settings

For MIDI System Exclusive communication, your sampler uses a Device ID 
number. For ReCycle to work, the Device ID setting on the sampler’s front panel 
and the ID specified in OMS must be identical. See your sampler’s documentation 
for instructions on how to check the Device ID setting.

If you need to change the Device ID in OMS Setup, proceed as follows:

1. Click on the current device ID.
It gets selected.

2. Type the new number.

3. Press [Return].
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4. If you prefer another icon for the device (this is purely a cosmetic deci-
sion), click on the Icon, select a new one and click OK.
ReCycle does not require any specific setting for all the remaining options in 
this dialog box, so...

5. Click OK to close the dialog box.

You should have a setup that looks something like this for a regular MIDI interface 
(in this case an S3000 on the Modem port):
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...and something like this for a multi-port interface:

● If the sampler is connected to a MIDI Patcher, make sure the Patcher's “De-
fault Program” allows you to have two-way communication between the 
computer and the sampler. See the OMS documentation for more information 
about Patchers.

Making the OMS Setup Current

1. From the File menu, select “Save”.

2. If a file dialog box appears, specify a name and location and Save the file.
The only reason you will need this file is if you want to change your setup at 
a later time.

3. Quit OMS Setup.
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Selecting the Sampler and testing MIDI communication
The procedure below allows you to test whether OMS is properly set up for your 
specific sampler:

1. In ReCycle, pull down the Sampler menu to select the sampler.
One of the options should correspond to your specific sampler. Details about 
this are found on page 107.

 

2. Select your sampler from this list.

3. Make sure the sampler is turned on, that the interface is activated etc.
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4. Select Receive from the Sampler menu.

The pop-up in the dialog box should now list the current samples in your sampler. 
The fact that the dialog appears without warnings, indicates that basic MIDI com-
munication works.
ReCycle 1.6 - Installing and Using OMS (Macintosh Users Only) Page  162 



How ReCycle interacts with OMS
If you are an experienced OMS user or if you have a special setup, this section is 
for you. It describes how ReCycle interacts with OMS. Use this information to-
gether with the OMS documentation to decide how you should set up your system.

• ReCycle requires two-way communication with the sampler. In other 
words, the MIDI Out on the sampler must be connected to a MIDI In on 
the interface, and the MIDI In on the sampler must be connected to a 
MIDI Out on the interface.

• When you launch ReCycle it checks with OMS whether there's any De-
vice in the current OMS setup with a Manufacturer, Model and Name 
corresponding to the samplers supported by ReCycle. If there is, it 
searches for it via MIDI. If the sampler replies, ReCycle creates a menu 
item for it on the Sampler menu.

• If there are several Devices in the OMS Setup which fit the above de-
scription, they all appear on the menu.
In other words, you can use ReCycle with several samplers of the same make 
and model.

• When transmitting and receiving, ReCycle uses the System Exclusive ID 
setting in OMS, so this has to match the one in the sampler.

• If you have more than one sampler of the same model, they must be set 
to different Device IDs.
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• The only settings in the Device dialog that are of any importance to Re-
Cycle are Manufacturer, Model, Name and Device ID. The remaining op-
tions may be set up as you like, or as your other OMS applications 
require.

• If you use a MIDI Patcher, please note that ReCycle never switches pro-
grams in it. Instead ReCycle just uses the Patcher configuration that hap-
pens to be active at the moment. Therefore we recommend that you set 
things up so that the “Default Patch” for the Patcher allows for two-way 
communication between the Sampler and the computer. Otherwise you 
have to manually switch in the correct Program in the Patcher before us-
ing ReCycle.
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Appendix B

Digidesign SampleCell B



Requirements and Support
ReCycle supports all models of SampleCell both on the Macintosh and Windows 
platforms.

Since ReCycle “only” creates SampleCell Instrument and Sample files which it 
saves to your computer’s hard disk, you do not need to have either MIDI or SCSI 
installed to use ReCycle with a SampleCell card. OMS is not required either.

Installation
Follow all the installation instructions in the SampleCell documentation. Since Re-
Cycle only saves SampleCell Instruments to your computer’s hard disk, you actu-
ally don’t even have to have the SampleCell card installed to be able to use 
ReCycle.
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Sampler Details

Documents Created

ReCycle saves the SampleCell audio as Multisample Instrument files together with 
a number of sample files, all in the same folder.

 You can save the sample files in any file format except Wave (WAV). But, if you 
want to add loop settings in the SampleCell editor, avoid the Sound Designer I for-
mat.

SampleCell I and II

ReCycle for Macintosh can be used with either of the two types of SampleCell 
cards for Macintosh, I and II. But, the Instruments ReCycle creates require the 
SampleCell II editor to be loaded.

● SampleCell I is limited to loading 20 samples into one Instrument. Therefore, 
you can not use loops with more than 20 slices with a SampleCell I card!

Mac:

Mac:

Mac:
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Preferences

In the SampleCell Macintosh Preferences dialog you will find a setting called “Au-
tomatically remap instruments in a bank after adding an instrument”.

● This preference must be turned off, or the first slice in a loop might have its 
tuning changed!

Loop Settings

In AIFF, Sound Designer II and Wave files, ReCycle will add Loop markers at the 
beginning and end of each slice. To make a sample actually loop, the only thing you 
have to do is to turn on looping in the SampleCell editor (this is probably most use-
ful when you have Transmit As One Sample turned on). If you know you want 
looping to start with, set up a Template Instrument with looping turned on.

Monophonic Setting

Among the SampleCell “Misc” parameters, you will find a setting called “Mono-
phonic”. In the default Instruments created by ReCycle, this is turned on, so that 
one sample cuts off the next. This is to ensure that stretched loops and loops played 
at higher tempi than the original sound as good as possible (since otherwise the 
slices might blend into each other).

Mac:
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Templates

With SampleCell, the mapping of samples on “the keyboard” is not read from the 
templates (due to the way key ranges are handled in SampleCell). In the Instru-
ments that ReCycle creates, the first sample is always put on the key C3.

SampleCell Tuning Parameters

The SampleCell editor allows you to perform some very powerful editing to the en-
tire Instrument and to the samples within it. However, there is one parameter which 
doesn’t really behave as you might expect.

The tuning parameter in the Miscellaneous group of parameters for an Instrument 
doesn’t really tune a sample, instead it shifts the MIDI input up or down along the 
“keyboard”. This means that instead of changing the pitch of all the slices in a loop, 
it will make the MIDI file play the wrong slices in the loop.

If you want to tune the slices in a loop you have two options:

• Either go into the key map and set the tuning individually for each slice in the 
loop, or...

• Map a modulation parameter to pitch and use that to change the pitch equally 
for all sounds in the Instrument.
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Sample Rates

SampleCell supports any sample rate, so no conversion is ever required with this in-
strument.
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Appendix C

Akai S1000, S2000 and S3000 seriesC



Requirements and Support
ReCycle supports all Akai samplers in the S1000, S2000 and S3000 series, includ-
ing all “XL”, “PB” and “i” variations. In this manual we refer to all the models in 
the 2000 and 3000 series as “the S3000”.

You need the following:

• The latest operating system for your sampler.

For MIDI Transfers:

• A MIDI interface and two MIDI cables, or...

• For MIDI on the Macintosh you need OMS (included with ReCycle).

For SCSI transfers

• A SCSI card.

• A SCSI cable.

It makes no difference to the functionality of the program whether you set up a 
MIDI or SCSI connection. The only difference is that SCSI transfers are much 
faster.

• Not all sampler models come with SCSI built in, so you might need to add 
a SCSI card to your sampler.

Mac:

Win:
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● There are some possible problems with SCSI transfers between Macintosh 
computers and the S1000/S1100. See page 184 for details.

● There are some problems with certain Akai samplers and Windows 95, see 
page 186 for details.

Mac:

Win:
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Which should I use – SCSI or MIDI?

If you have a Macintosh

• If you have a Macintosh and a sampler in the S3000 series, we recommend 
that you use SCSI. It is much faster than MIDI.

• If you have an S1000 or S1100, you should use SCSI if you have one of the 
Macintosh models that are compatible with the S1000/S1100. Otherwise, use 
MIDI. See page 184 for details.

MIDI communication requires you to install OMS, see page 149.

If you are using Windows

• If you have a PC computer without SCSI, you have no choice. MIDI is your 
only option.

• If you have a SCSI card in your computer which is 100% Adaptec “ASPI for 
DOS” compatible, we recommend that you use that.

Mac:

Win:
ReCycle 1.6 - Page  174 



Installation

MIDI Connections

If you want to use MIDI, proceed as follows:

1. Connect a MIDI Cable from the MIDI Out on the sampler to a MIDI In on 
your computer.

2. Connect a MIDI cable from a MIDI Out on your computer to the MIDI In 
on the sampler.

SCSI Connections

Akai samplers only have one SCSI connector. If you have more than one Akai 
sampler, you need a SCSI splitter cable or box. This will allow you to connect 
all units to the computer at the same time.

● To be able to set up a system with more than one Akai Sampler you need to 
remove termination in all samplers but one. Contact a qualified Akai Service 
centre.
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General SCSI Rules!

SCSI is a high speed electrical interface, primarily designed to connect hard disks 
and other peripherals to personal computers. SCSI is not a regular computer net-
work so there are severe restrictions on how many devices you can have connected, 
cable lengths etc.

● Improper SCSI handling might cause permanent damage to your equipment. 
Please, always follow the few but important golden rules of SCSI to insure 
yourself against damaged equipment:

• Always make all connections with power on all units turned off!

• Use high quality SCSI cables! The shorter they are, the better.

• The total length of all SCSI cables should never exceed 6 meters (20 feet).

• The devices at the ends of your SCSI chain must be terminated! 
Akai samplers have terminators built in, but these can be removed if needed 
(contact an Akai service centre for more info). 
Macintosh computers and SCSI cards for PC also have termination built in, 
but this should under no circumstances be removed.
If you set up with too many terminators, or a terminator missing, data trans-
mission most probably won’t work properly. In the worst case, one of your 
SCSI devices might get physically damaged.
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• The computer should always be at one end of the SCSI chain of devices.

• Set all devices to different IDs before turning on power!
Akai samplers are normally set to 6, but this can be changed.
Macintosh computers and their internal hard disks always occupy IDs 0 and 
7. 
PC SCSI cards are normally set to ID 7.

• Always turn on the computer last, after all other devices have finalised 
their startup processes.

• Always switch on all devices. If some device is not turned on, you may 
lose data.

Booting Up and Making System Settings

1. Make sure you have the latest operating system for your sampler. ReCycle 
may not be able to communicate with the sampler if you don’t have a 
current version.
If in doubt, contact your Akai dealer.

● Operating System updates for Akai samplers might be installed inside your 
sampler or arrive on a floppy disk (which can be copied to a hard disk). If you 
have your operating system on a floppy disk, this disk must always be inserted 
into the drive when you turn on the sampler.
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2. Turn on the sampler. If it is loading the operating system from the floppy, 
let it finish loading everything before turning on any other devices.

Setting MIDI System Exclusive IDs

The following only applies to Windows users who use MIDI for communication 
between ReCycle and the sampler.

In the Windows version of ReCycle, automatic installation of samplers via MIDI 
requires you to make sure the sampler has a “MIDI Exclusive Channel setting” of 1 
to 4 and not higher.

1. Press the MIDI Button.

2. Press the EXCL button (F6).

3. Locate the parameter called “MIDI EXCLUSIVE Channel” and change it if 
needed.

Setting SCSI IDs

The Akai samplers are normally set to SCSI ID 6. If you only have the sampler con-
nected via SCSI, this will work fine. If you have other peripherals, or more than one 
S3000, you need to check that all devices are set to different IDs.

To check the SCSI ID of an Akai sampler, proceed as follows:

Win:
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1. Press the MIDI Button.

2. Press the SCSI button (F7).

3. Locate the parameter called “local SCSI ID” (S3000 series) or “S1000/
1100 SCSI ID” (S1000/1100) and change it if needed.

Turning on the computer and Launching ReCycle

1. Turn on all other computer peripherals and let them start up.

2. Turn on your computer.

If the computer refuses to boot (the computer “hangs” during startup) there’s some-
thing wrong with the termination, cables or SCSI IDs. Windows users might also 
want to check IRQ settings. Go back and check everything again. Try with less 
equipment connected (but don’t forget – always terminate both ends of the SCSI 
chain!).

3. Check that the sampler(s) appear on the Sampler menu in ReCycle.
If they don’t, they haven’t been found by the program. Also, if the sampler(s) 
are booted with the wrong operating system version, a dialog box will inform 
you and the sampler(s) will not be added to ReCycle’s Sampler menu.
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About SCSI Scan

When you launch ReCycle it scans for Akai samplers on the SCSI bus. If it finds 
one, it appends it to the Sampler menu, indicating it is connected via SCSI and 
showing the SCSI ID number.
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Sampler Details

Transmitting

When you Transmit a sample to an Akai sampler, ReCycle always creates new 
Samples, Keygroups and a Program to put it all in.

Templates

If you use Templates (as described on page 119), ReCycle copies all settings in the 
Template Program to the Program it creates.

The lowest note number of the first keygroup in the template Program (the Key-
group furthermost to the left on the “keyboard”) is used for the first sample ReCy-
cle transmits. All other samples are positioned chromatically upwards.

If you want to use templates to position your ReCycle samples on a certain part of 
the “keyboard”, you might create a Program on your sampler, with only one Key-
group in, positioned where you want the first sample. You could even have a 
number of such dummy Programs on your sampler startup disk, which would allow 
you to use the Template pop-up menu in the Transmit dialog to simply select where 
on the “keyboard” your ReCycled samples will appear.
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Playback Modes

When you slice a sample, we recommend that you set the samples to “PLAY TO 
SAMPLE END” (to ensure it doesn’t loop and to make sure the entire sample 
plays). This can be done either for an individual sample or as a setting in the Key-
group. See your Akai sampler manual for more information.

Loop settings

ReCycle will put the loop points at the beginning and end of each slice. To make a 
sample actually loop when you hold down the key, the only thing you have to do is 
to turn on looping (this is probably most useful when you have Transmit As One 
Sample turned on). If you know you want looping to start with, set up a Template 
Program with looping turned on.

“Mute Group” setting

Among the Keygroup parameters, you will find a setting called “Mute Group”. In 
the default Programs created by ReCycle, this is set to “1” for all samples, so that 
one sample cuts off the next. This is to ensure that stretched loops and loops played 
at higher tempi than the original, sound as good as possible (since otherwise the 
slices might blend into each other).
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Keygroups

The Slices are loaded into one keygroup each. By using “Edit One Keygroup” or 
“Edit All Keygroups” it is very easy to get creative with the Akai samplers.

• In “All” mode you might for example mimic a pitch shift by changing the tun-
ing of all samples. Or you might change the Decay of the sounds by altering 
all keygroups’ envelopes.

• In “One “mode you can pitch different samples individually or set them to dif-
ferent Outputs, panning etc.
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S1000/1100 – Macintosh Pitfalls
Due to incompatibility between the Macintosh and Akai S1000/S1100 SCSI imple-
mentations, SCSI communication between ReCycle and these samplers does not 
work reliably on all Macintosh models. We have successfully used ReCycle with an 
S1000 and the following Macintosh computers:

• IIfx
• Quadra/Centris 650
• Quadra 840 AV
• Various stationary Power Macintosh computers

If you have one of those, we think you should try it. If you have any other model, 
only experimentation will tell if things work. It is likely that Macintosh models 
which require the SCSI Manager 4.3 or later will work better than others.

● It is very unlikely that this problem will cause any permanent damage to your 
equipment. Still, Steinberg does not take responsibility whatsoever for lost 
data or damaged equipment! 

How do I know if it works?

Some transfers will almost certainly work, some time. What happens when things 
do go wrong is simply that the system hangs indefinitely during a transfer. Techni-
cally, nothing is actually “broken”, it is just that the two machines are waiting for 
each other, and will do so for an infinite amount of time. 
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Slow transfers

If you have many samples (more than one hundred) in your Akai S1000/S1100, 
SCSI transfers are very slow. Do not confuse this with a “hung” system.
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Window 95 Pitfalls
The SCSI drivers in Windows 95 only work with devices that at all times reply cor-
rectly to a SCSI 2 Device Inquiry message. Unfortunately, some Akai samplers (as 
of this writing) don't.

If you have any of the following samplers, you need to read on:

• Akai S1000 or S1000 (or any variations on these models, such as the PB 
versions).
The S1000/1100 will most likely never work with the Windows 95 SCSI driv-
ers, unless Microsoft make changes to Windows 95.

• Akai S2000 or S3200XL with operating system 1.51 or older (this in-
cludes any variations on these models).
These models are expected to work if they have later versions of the operating 
system installed.

• Akai S2800, S3000 or S3200 with operating system 2.01 or older (this in-
cludes any variations on these models.
These models are expected to work if they have later versions of the operating 
system installed.
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Workarounds

If you need to use Windows 95 with any of the samplers listed above, you have to 
disable the SCSI drivers in Windows 95 and instead use ASPI for DOS (see page 38 
for more info about ASPI for DOS).

This means that other SCSI devices and SCSI software you have, written specifi-
cally for Windows 95, might stop working. However, if you only use your SCSI 
card for ReCycle you won't notice any difference at all. If you also use it for an ex-
ternal hard disk and/or CD-ROM, things should also work without problems.

Proceed as follows:

1. In Windows 95, select Settings from the Start menu, and from this menu, 
open the Control Panel. Double click on the System icon.

2. Click on the Device Manager tab.

3. Locate the SCSI Controller section in the list. If required, “open” it by 
clicking the “+” icon.

4. Double click on your specific SCSI device driver.

5. Click on the General tab.

6. Deactivate the driver in the white “Device Usage” box, by clicking the 
check box.
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7. Click OK in all dialogs and close the Control Panel window.

8. Install ASPI for DOS as described in its documentation. 
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In case of transfer problems
Even if you have followed the general SCSI guidelines above, there might be ex-
treme situations where you could possibly run into problems with SCSI. If the com-
puter freezes, as a result of communication problems during a transfer to the 
sampler, proceed as follows:

1. On the sampler, make a “Save Entire Volume” to new empty floppy disks. 
Do not overwrite earlier disks and do not save to hard disk, since the data 
you save now may be corrupted.

2. Check through the Programs in the sampler and delete those that didn't 
get transferred accurately. Check that the remaining Programs seem to be 
intact. Save to floppy again.

3. Restart the sampler and the computer, and try the transfer again.

The only way to insure yourself totally against loss of important material is to Save 
on the sampler, as often as possible.
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Appendix D

Roland S-760 D



Requirements and Support
• ReCycle supports the Roland S-760.

You need the following:

• S-760 operating system 2.17 or later.

• A MIDI interface and two MIDI cables.

• For MIDI on the Macintosh you need OMS (included with ReCycle).

• To do SCSI transfers on a PC you need a SCSI card.

• For SCSI transfers you need a SCSI cable.
It makes no difference to the functionality of the program whether you set up 
a SCSI connection or not. The only difference is that SCSI transfers are much 
faster.

• Your S-760 might not come with SCSI built in, so you might need to add 
a SCSI card to it.

● Currently, the S-760 does not support Windows 95's built in SCSI drivers, you 
need to install ASPI for DOS, regardless of which Windows version you use. 
See page 199.
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Installation

MIDI Connections

1. Connect a MIDI Cable from the MIDI Out on the sampler to a MIDI In on 
your computer.

2. Connect a MIDI cable from a MIDI Out on your computer to the MIDI In 
on the sampler.
If you have a multi-port interface, connect the In and Out to the same port 
number.

SCSI Connections

General SCSI Rules!

● SCSI is a high speed electrical interface, primarily designed to connect hard 
disks and other peripherals to personal computers. SCSI is not a regular com-
puter network so there are severe restrictions on how many devices you can 
have connected, cable lengths etc.
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Improper SCSI handling might cause permanent damage to your equipment. 
Please, always follow the few but important golden rules of SCSI to insure 
yourself against damaged equipment:

• Set all devices to different IDs before connecting and turning on power!
Macintosh computers and their internal hard disks always occupy IDs 0 and 
7. Internal Macintosh CD-ROM drives are often set to ID 3.
PC SCSI cards normally occupy the SCSI ID 7.

• The S-760 is normally set to ID 7 so this needs to be changed from the front 
panel!

• Always make all connections with power on all units turned off!
• Use high quality SCSI cables! The shorter they are, the better.
• The total length of all SCSI cables should never exceed 6 meters (20 feet).
• The devices at the ends of your SCSI chain must be terminated! 
• Follow the recommendations in your sampler manual about how to terminate 

your devices.
• If you set up with too many terminators, or a terminator missing, data trans-

mission most probably won’t work properly. In the worst case, one of your 
SCSI devices might get physically damaged.

• The computer should always be at one end of the SCSI chain of devices.
• Always turn on the computer last, after all other devices have finalized their 

startup processes.
• Always switch on all devices. If some device is not turned on, you may lose 

data. 
ReCycle 1.6 - Page  193 



Booting Up and Making System Settings

1. Make sure you have the latest operating system for your sampler. ReCycle 
may not be able to communicate with the sampler if you don’t have a 
current version. If in doubt, contact your dealer.

2. Turn on the sampler. Let it finish booting.

3. On the S-760, press the Mode button and select “System Mode”. Press 
the value button twice to get to the System menu.

4. Select “SCSI” and press the Value button to enter the SCSI menu.

5. Locate the “S-760 Self SCSI ID“ parameter and change it if needed.
For the Macintosh, make sure it is not set to 0 or 7. On the PC avoid SCSI ID 
7 (since these numbers are occupied by your computer). Also make sure that 
this setting is not set to the same ID as any other device connected to the SCSI 
bus.

6. Press the Value button to exit, select “MIDI” and press Value again to en-
ter the MIDI menus.

7. On the MIDI menus make sure that “MIDI Out/Thru” is set to Out, and 
that “Exclusive RX” is set to On.
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8. Macintosh users need to make a note of the “Device ID” setting (you will 
need to enter this number in OMS Setup later).

9. Press the Mode button, select “Performance” and press the Value button 
again to enter Performance Play mode.

10.Turn on all other computer peripherals and let them start up.

11.Turn on your computer.

12.If the computer refuses to boot (the computer “hangs” during startup) 
there’s something wrong with the termination, cables or SCSI IDs. Go 
back and check everything again. Try with less equipment connected (but 
don’t forget – always terminate both ends of the SCSI chain!).

Launching and Setting Up OMS (Macintosh only!)

Turn to page 149 and set up OMS as described there. The settings you need to make 
for your S-760 Device are as follows:

• Manufacturer: Roland
• Model: S-760
• Name: S-760
• Device ID: Same as the MIDI Device ID setting on the sampler.
• The remaining settings are of no importance to ReCycle.
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Launching ReCycle

1. Launch ReCycle.

2. Check that the sampler appears on the Sampler menu in ReCycle. If the 
MIDI connection seems to work, the MIDI ID will be indicated in the 
menu item. If the sampler has also been found on the SCSI bus (if it is 
connected via SCSI), the SCSI ID will also be displayed here. If either of 
these indications do not appear, the sampler hasn't been found properly 
by the program.

Sampler Details

S-760 must be in Performance mode!

● The S-760 must always be in Performance mode when transmitting or receiv-
ing samples!

Transmitting

When you Transmit a sample to an S-760, ReCycle always creates new Samples 
and Partials and a Patch to put it all in.
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The default Volume ID for ReCycle Patches is “RCY”. This can be changed before 
transmission, by editing the name in the Transmit dialog.

Templates

If you use Templates (as described on page 64 in the printed manual), ReCycle cop-
ies all settings in the Template Patch to the Patch it creates.

The lowest note number in the template Patch (the Partial furthermost to the left on 
the “keyboard”) is used for the first sample ReCycle transmits. All other samples 
are positioned chromatically upwards.

If you want to use templates to position your ReCycle samples on a certain part of 
the “keyboard”, you might create a Patch on your sampler, with only one Partial/
Sample in, positioned where you want the first sample. You could even have a 
number of such dummy Patches on your sampler startup disk, which would allow 
you to use the Template pop-up menu in the Transmit dialog to simply select where 
on the “keyboard” your ReCycled samples will appear.
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Loop settings

ReCycle will put the loop points at the beginning and end of each slice. To make a 
sample actually loop when you hold down the key, the only thing you have to do is 
to change looping, from OneShot to whatever mode is required for your application 
(this is probably most useful when you have Transmit As One Sample in ReCycle 
turned on). If you know you want looping to start with, set up a Template Patch 
with looping turned on.

Monophonic setting

Among the Patch Split parameters for a Patch, you will find a setting called “Assign 
Type”. In the default Patches created by ReCycle, this is set to “Exc 1”, so that one 
sample cuts off the next. This is to ensure that stretched loops and loops played at 
higher tempi than the original, sound as good as possible (since otherwise the slices 
might blend into each other). If this doesn't suit your application, simply set this pa-
rameter to “Poly” instead.
ReCycle 1.6 - Page  198 



 Windows 95 Pitfalls
The SCSI drivers in Windows 95 only work with devices that at all times reply cor-
rectly to a SCSI 2 Device Inquiry message. Unfortunately, the S-760, as of this 
writing, doesn’t.

Workarounds

If you need to use Windows 95 with the S-760, you have to disable the SCSI drivers 
in Windows 95 and instead use ASPI for DOS (see page 38 more info about ASPI 
for DOS).

This means that other SCSI devices and SCSI software you have, written specifi-
cally for Windows 95, might stop working. However, if you only use your SCSI 
card for ReCycle you won't notice any difference at all. If you also use it for an ex-
ternal hard disk and/or CD-ROM, things should also work without problems.

Proceed as follows:

1. In Windows 95, select Settings from the Start menu, and from this menu, 
open the Control Panel. Double click on the System icon.

2. Click on the Device Manager tab.

3. Locate the SCSI Controller section in the list. If required, “open” it by 
clicking the “+” icon.
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4. Double click on your specific SCSI device driver.

5. Click on the General tab.

6. Deactivate the driver in the white “Device Usage” box, by clicking the 
check box.

7. Click OK in all dialogs and close the Control Panel window.

8. Install ASPI for DOS as described in its documentation. 
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Appendix E

Kurzweil K2000/K2500 E



Requirements and Support
ReCycle supports the Kurzweil K2000 and K2500 and their rack versions.

You need the following:

• The K2000 needs operating system 3.01 or later. The K2500 needs oper-
ating system 2.13 or later.

• A MIDI interface and two MIDI cables.

• For MIDI on the Macintosh you need OMS (included with ReCycle).

• To do SCSI transfers on a PC you need a SCSI card.

• For SCSI transfers you need a SCSI cable.
It makes no difference to the functionality of the program whether you set up 
a SCSI connection or not. The only difference is that SCSI transfers are much 
faster.
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Installation

MIDI Connections

1. Connect a MIDI Cable from the MIDI Out on the sampler to a MIDI In on 
your computer.

2. Connect a MIDI cable from a MIDI Out on your computer to the MIDI In 
on the sampler.
If you have a multi-port interface, connect the In and Out to the same port 
number.
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SCSI Connections

General SCSI Rules!

● SCSI is a high speed electrical interface, primarily designed to connect hard 
disks and other peripherals to personal computers. SCSI is not a regular com-
puter network so there are severe restrictions on how many devices you can 
have connected, cable lengths etc.
Improper SCSI handling might cause permanent damage to your equipment. 
Please, always follow the few but important golden rules of SCSI to insure 
yourself against damaged equipment:

• Set all devices to different IDs before connecting and turning on power!
Macintosh computers and their internal hard disks always occupy IDs 0 and 
7. Internal Macintosh CD-ROM drives are often set to ID 3.
PC SCSI cards normally occupy the SCSI ID 7.

• The Kurzweil samplers are normally set to ID 6 but this can be changed from 
the front panel if needed.

• Always make all connections with all units turned off!
• Use high quality SCSI cables! The shorter they are, the better.
• The total length of all SCSI cables should never exceed 6 meters (20 feet).
• The devices at the ends of your SCSI chain must be terminated! 
• Follow the recommendations in your sampler manual about how to terminate 

your devices.
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• If you set up with too many terminators, or a terminator missing, data trans-
mission most probably won’t work properly. In the worst case, one of your 
SCSI devices might get physically damaged.

• The computer should always be at one end of the SCSI chain of devices.
• Always turn on the computer last, after all other devices have finalized their 

startup processes.
• Always switch on all devices. If some device is not turned on, you may lose 

data. 

Booting Up and Making System Settings

1. Make sure you have the latest operating system for your sampler. ReCycle 
may not be able to communicate with the sampler if you don’t have a 
current version. If in doubt, contact your dealer.

2. Turn on the sampler and any connected external SCSI devices. Let the 
sampler finish booting.

3. Turn on your computer.

4. If the computer refuses to boot (the computer “hangs” during startup) 
there’s something wrong with the termination, cables or SCSI IDs. Go 
back and check everything again. Try with less equipment connected (but 
don’t forget – always terminate both ends of the SCSI chain!).
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Checking the MIDI System Exclusive IDs

1. Go to the MIDI Receive parameters page on your K2000.

2. Check the SysEx ID setting. If you have more than one K2000 they must 
be set to different IDs.

Launching and Setting Up OMS (Macintosh only!)

Turn to page 149 and set up OMS as described there. The settings you need to make 
for your Kurzweil Device are as follows:

K2000

• Manufacturer: Kurzweil
• Model: K2000
• Name: K2000
• Device ID: Same as the SysEx ID setting on the sampler (see above).
• The remaining settings are of no importance to ReCycle.

K2500

• Manufacturer: Kurzweil
• Model: K2500, or if it can’t be found on the menu, “Other”.
• Name: K2500
• Device ID: Same as the SysEx ID setting on the sampler (see above).
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• The remaining settings are of no importance to ReCycle.

Launching ReCycle

1. Launch ReCycle.

2. Check that the sampler appears on the Sampler menu in ReCycle. If the 
MIDI connection seems to work, the MIDI ID will be indicated in the 
menu item. If the sampler has also been found on the SCSI bus (if it is 
connected via SCSI), the SCSI ID will also be displayed here. If either of 
these indications do not appear, the sampler hasn't been found properly 
by the program.
If you run into problems, check your settings and connections and try again, 
using use “Search for Samplers”.
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Sampler Details

Transmitting

When you Transmit slices to a K2000/K2500, ReCycle always creates new Sam-
ples and Keymaps and a Program to put it all in.

Templates

If you use Templates (as described on page 64 in the printed manual), ReCycle cop-
ies all settings in the Template Program to the Program it creates.

The lowest note number of the first layer in the template Program (the layer further-
most to the left on the “keyboard”) is used for the first sample ReCycle transmits. 
All other samples are positioned chromatically upwards.

If you want to use templates to position your ReCycle samples on a certain part of 
the “keyboard”, you might create a Program on your sampler, with only one layer 
in, positioned where you want the first sample. You could even have a number of 
such dummy Programs in your sampler, which would allow you to use the Tem-
plate pop-up menu in the Transmit dialog to simply select where on the “keyboard” 
your ReCycled samples will appear.
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Loop settings

ReCycle will put the loop points at the beginning and end of each slice. To make a 
sample actually loop when you hold down the key, the only thing you have to do is 
to turn on looping in the sampler (this is probably most useful when you have 
Transmit As One Sample turned on). If you know you want looping to start with, 
set up a Template Program with looping turned on.

Monophonic setting

Among the Common parameters for a Program, you will find a setting called 
“Monophonic”. In the default Programs created by ReCycle, this is activated, so 
that one sample cuts off the next. This is to ensure that stretched loops and loops 
played at higher tempi than the original, sound as good as possible (since otherwise 
the slices might blend into each other). If this does not suit your application, simply 
change this setting in the sampler, after transmitting, or use a template with this 
function turned off.
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Appendix F

Ensoniq Samplers F



Requirements and Support
ReCycle supports the Ensoniq EPS, EPS-16+, ASR-10 and ASR-88.

You need the following:

• The latest operating system for the sampler.

• A MIDI interface and two MIDI cables.

• For MIDI on the Macintosh you need OMS (included with ReCycle).

Installation

MIDI Connections

1. Connect a MIDI Cable from the MIDI Out on the sampler to a MIDI In on 
your computer.

2. Connect a MIDI cable from a MIDI Out on your computer to the MIDI In 
on the sampler.
If you have a multi-port interface, connect the In and Out to the same port 
number.
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Making Sampler System Settings

1. Make sure you have the latest operating system for your sampler. ReCycle 
may not be able to communicate with the sampler if you don’t have a 
current version. If in doubt, contact your dealer.

2. Turn on the sampler. Let it finish booting before turning on any other de-
vices.

3. Among the sampler's System parameters, make sure “MIDI SYS-EX” is set 
to ON. Macintosh users should also make a note of the “MIDI BASE 
CHANNEL” setting (you will need this number in OMS Setup later).
We also suggest you save the settings using the “SAVE GLOBAL PARAME-
TERS” option.

Launching and Setting Up OMS (Macintosh only!)

Turn to page 149 and set up OMS as described there. The settings you need to make 
for your Ensoniq Device are as follows:

• Manufacturer: Ensoniq
• Model: Other for EPS, EPS-16+ for EPS-16+, and  ASR-10 for both ASR-10 and 

ASR-88.
• Name: EPS, EPS-16+, ASR-10 or ASR-88.
• Device ID: Same as the “MIDI BASE CHANNEL” setting on the sampler.
ReCycle 1.6 - Page  212 



• The remaining settings are of no importance to ReCycle.

Launching ReCycle and checking MIDI

1. Launch ReCycle.

2. To test the MIDI communication, pull down the Sampler menu and select 
Receive. Try receiving a short sample into a ReCycle window.
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Sampler Details

Transmitting

The Transmit dialog allows you to specify an Instrument slot and a name for the In-
strument. When you Transmit to the EPS/ASR, ReCycle always creates new Wave-
Samples, Layers and Instruments, as needed.

Templates

Templates are not implemented for the EPS/ASR.

Loop settings

ReCycle will put the loop points at the beginning and end of each slice. To make a 
sample actually loop when you hold down the key, the only thing you have to do is 
to turn on looping in the sampler (this is probably most useful when you have 
Transmit As One Sample turned on).
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Glidemode mono setting

When you stretch a loop or play back a loop at a higher tempo than the original, 
you might not want the slices to overlap, since they then blend into each other. To 
avoid this make sure the Layer’s Glidemode parameter is set to Legato. This makes 
the Layer monophonic, so that one slice always cuts off the next.
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Appendix G

E-mu Samplers G



Requirements and Support
ReCycle 1.6 supports:

• The E-mu Esi-32.
• The EIV (E4), e64, E4K and future samplers running the same operating system 

(EOS) and using the same SCSI routines.

You need the following:

• Operating System 2.10 or later for the Esi-32, and Operating System 2.50 
or later for the other models.

• On the PC you need a SCSI card.

• A SCSI cable.

Communication between the computer and the sampler happens via SCSI only, 
which means that MIDI connections and OMS are not required.

● Please note the warning for Windows 95 users below!!!

Win:
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Connecting

General SCSI Rules!

● Please note the warning for Windows 95 users below!!!

● SCSI is a high speed electrical interface, primarily designed to connect hard 
disks and other peripherals to personal computers. SCSI is not a regular com-
puter network so there are severe restrictions on how many devices you can 
have connected, cable lengths etc.

Improper SCSI handling might cause permanent damage to your equipment. 
Please, always follow the few but important golden rules of SCSI to insure 
yourself against damaged equipment:

• Set all devices to different IDs before connecting and turning on power!
Macintosh computers and their internal hard disks always occupy IDs 0 and 
7. Internal Macintosh CD-ROM drives are often set to ID 3.
PC SCSI cards normally occupy the SCSI ID 7.

• The E-mu sampler is normally set to ID 5 but this can be changed from the 
front panel if needed.

• Always make all connections with all units turned off!
• Use high quality SCSI cables! The shorter they are, the better.
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• The total length of all SCSI cables should never exceed 6 meters (20 feet).
• The devices at the ends of your SCSI chain must be terminated! 
• Follow the recommendations in your sampler manual about how to terminate 

your devices.
• If you set up with too many terminators, or a terminator missing, data trans-

mission most probably won’t work properly. In the worst case, one of your 
SCSI devices might get physically damaged.

• If your sampler has a “Mac on SCSI bus” or “Avoid Host on ID” setting, please 
activate this. If a certain SCSI Device ID can be selected, set it to the same 
number as your computer/SCSI card (normally 7).

• The computer should always be in one end of the SCSI chain of devices.
• Always turn on the computer last, after all other devices have finalized their 

startup processes.
• Always switch on all devices. If some device is not turned on, you may loose 

data. 
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Windows 95 warning!!!

● Due to incompatibilities between the way Windows 95 and E-mu handle hard 
disks, Windows 95 is likely to trash your E-mu hard disk during startup! If this 
happens, all the data on the disk will be lost, and you will have to re-format it. 
This has nothing to do with ReCycle, it happens on computers running Win-
dows 95, regardless of whether you have ReCycle installed or not.

EIV (E4), e64 and E4K and other samplers running EOS operating system

On these samplers it might be possible to avoid the problem by locking the hard 
disk while Windows 95 starts up.

● This method is not fool-proof, Windows 95 might write to the disk even 
though it’s locked from the E-mu sampler! Steinberg do not take responsibility 
for the following procedure working as intended. Back up the data on the disk 
before proceeding! You proceed completely at your own risk!

1. Press the DISK button.

2. Press Browse (F2).

3. Select the disk, and press Info (F6).
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4. Use F3 to Lock the disk.

5. Press F6 (OK).

6. Boot up your computer and Windows 95.

7. Unlock the hard disk, using the method described above.

Esi-32

The Esi-32 does not have a “lock disk” feature. However, if you use removable 
disks (“Syquest”, “Jaz”, “Zip” etc), you might get around the problem by making 
sure there is no media in the drive when Windows 95 is launched.

● Again, this method is not fool-proof! Steinberg do not take responsibility for 
your data being damaged! Before you try the above, back up the data on the 
disk! Remember you proceed completely at your own risk!
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Booting Up
1. Make sure you have the correct operating system for your sampler (see 

the introduction to this chapter). ReCycle will not be able to communi-
cate correctly with the sampler if you don’t have a current version. If in 
doubt, contact your dealer.

2. Turn on the sampler and any connected external SCSI devices. Let the 
sampler finish booting.

3. Turn on your computer.

● Sometimes a different boot order is required with E-mu samplers, see the 
heading “Launching ReCycle”, below.

4. If the computer refuses to boot (the computer “hangs” during startup) 
there’s something wrong with the termination, cables or SCSI IDs. Go 
back and check everything again. Try with less equipment connected (but 
don’t forget – always terminate both ends of the SCSI chain!).
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Windows 95 Device check

When you launch Windows 95 the first time after connecting the sampler via SCSI, 
it will ask you if you want to install a driver for it.

A driver is not required, so you can safely click the “Do not install a driver...” op-
tion.

● It may happen that this request appears not once, but eight times in a row! 
Simply click the same option each time until all dialogs go away. This is an id-
iosyncrasy of the sampler and nothing to worry about!

After installation you will find your E-mu sampler installed as eight “Other de-
vices” in the Control Panel. Again, this is nothing to be concerned about.

Launching ReCycle

1. Launch ReCycle.

2. Check that the sampler appears on the Sampler menu in ReCycle. The 
SCSI ID will be indicated in the menu item. If this indication does not ap-
pear, the sampler hasn't been found on the SCSI bus.
On some systems a special boot order might be required to make an E-mu 
sampler appear on the SCSI bus. Try booting the system nornmally, then re-
boot the sampler or computer. Launch ReCycle and check again.
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Sampler Details

Receiving

Numbering

Samples that you want to receive in from your sampler are identified by number. 
Use the editing facilities on your sampler to find out which number a certain sample 
has, type in this number in the Receive dialog and click Receive.

Stereo

ReCycle does not receive stereo samples. On samplers running the EOS operating 
system, the following will happen if you try:

1. ReCycle puts up a dialog, telling you a stereo sample can not be received.

2. The sampler will pause for a moment, waiting for the communication to 
“time out”.
Please have some patience, this may take quite a while.

3. After the “time out”, a message will appear on the sampler’s display, in-
forming you that the communication failed.

4. Press the “OK” soft button on the sampler. 
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Transmitting

Since more or less only the basic SMDI specification is supported by the E-mu 
samplers at this point, some care must be taken when transmitting samples. Pro-
ceed as follows:

1. On the sampler, select a Preset where you want to insert the samples.
The samples are always entered into the current Preset starting at the key C1. 
The transmitted samples will overwrite any existing samples in the key range 
used. Therefore, we recommend that you use an empty Preset.

2. Make an approximation of how many samples you will transmit, that is 
how many slices you currently have in your loop in ReCycle.

3. In the E-mu sampler, find a range of currently unused sample numbers 
and enter the lowest of these in the Transmit dialog.
This range of unused sample numbers must accommodate all the slices you 
plan to transmit. If you for example plan to transmit 15 slices and enter the 
number 10, sample numbers 10 to 24 must be unused. If these sample num-
bers are not unused but rather “contain” samples, these will get overwritten!

4. Enter a basic name for the samples.

5. Click Transmit.
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Templates

Templates are not implemented for E-mu samplers.

Loop settings

ReCycle will put the loop points at the beginning and end of each slice. To make a 
sample actually loop when you hold down the key, the only thing you have to do is 
to turn on looping in the sampler (this is probably most useful when you have 
Transmit As One Sample turned on).

Parameter settings

Since the samples are “injected” into the current Preset, no special parameter set-
tings are made. You might want to manually adjust envelopes and other settings to 
make the slices play back as “transparently” as possible. Or, you might want to 
modify parameters to purposely change the sound!

One important setting is the Output Channel parameter. When you stretch a loop or 
play back a loop at a higher tempo than the original, you might not want the slices 
to overlap, since they then blend into each other. To avoid this, you need to make 
the zone monophonic.

• On the Esi-32 this is done by assigning one Output Channel only to the 
zone playing the sliced samples.
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• On samplers running the EOS operating system, assign all the samples to 
the same key zone and set that key zone to Solo mode (mono).
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